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1 About this Manual 

1.1 Organization 

This manual contains the following chapters: 

Chapter 2 introduces the ibaRotate program. It provides an overview of this manual, and 

describes the additional analysis features available in ibaRotate. 

Chapter 3 demonstrates how to operate the software by leading you through a tour of 

the basic features with a quick start tutorial. 

Chapter 4 describes the powerful analysis tools available in ibaRotate. It begins with 

some general notes on collecting data. Then each section includes a description of the 

analysis tool, some possible applications, conditions for the input data, and a brief 

explanation of the theory behind the analysis tool. 

Chapter 5 describes the various plotting tools available in ibaRotate. It covers both the 

plotting features and the different types of plots. 

Chapter 6 describes various topics for direct reference by the user. The topics are 

arranged alphabetically and cover different aspects of the program. 

1.2 Designations 

The following designations are used in this manual: 

Action Designations 

Menu command Menu „Logic diagram“ 

Call of menu command „Step 1 – Step 2 – Step 3 – Step x” 

Example: 

Select menu „Logic diagram – Add – New logic 

diagram” 

Keys <Key name> 

Example: <Alt>; <F1> 

Press keys simultaneously <Key name> + <Key name> 

Example: 

<Alt> + <Ctrl> 

Buttons <Button name> 

Example: 

<OK>; <Cancel> 

File names, Paths „File name“, „Path” 

Example: 

„Test.doc“ 
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1.3 Used Symbols 

If safety instructions or other notes are used in this manual, they mean: 

 

 

 

The non-observance of this safety information may result in an imminent risk of death or 

severe injury: 

 By an electric shock! 

 Due to the improper handling of software products which are coupled to input 

and output procedures with control function! 

 

 

 

The non-observance of this safety information may result in a potential risk of death or 

severe injury! 

 

 

 

The non-observance of this safety information may result in a potential risk of injury or 

material damage! 

 

 

Note 

A note specifies special requirements or actions to be observed. 

 

 

Important note 

Note if some special features must be observed, for example exceptions from the rule. 

 

 

Tip 

Tip or example as a helpful note or insider tip to make the work a little bit easier. 

 

 

Other documentation 

Reference to additional documentation or further reading. 

 

1.4 Terms Used in This Guide 

Time waveform is used for any time domain signal that you can process in ibaRotate. 

This includes, but is not limited to, signals from tachometers, accelerometers, non-

contact eddy current probes, encoders, and microphones. 

Order normalization is used in describing the process of re-sampling a time waveform 

using a constant angular rotational interval, as opposed to conventional sampling using 

a constant time interval. 
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2 Overview of ibaRotate 

This chapter provides an overview of the capabilities in ibaRotate, which can assist you 

in evaluating rotating machinery and vibrating machinery. ibaRotate is a powerful tool to 

assist you with processing measurements from complex dynamic environments, 

identifying sources of vibration and shaft torsion, and diagnosing machine problems. 

2.1 ibaRotate Capabilities 

ibaRotate is a powerful software package for analyzing noise and vibration in mechanical 

equipment. It includes a set of analytical functions that process machine speed 

(tachometer) and time waveform (data) signals from almost any type of sensor. 

ibaRotate is designed for engineers and advanced machinery analysts who diagnose 

vibration, acoustic, and other problems. ibaRotate takes raw time waveform data as the 

input, and lets you analyze the data in many different ways to support the clearest 

diagnosis. However, you must understand the machinery and be able to identify the 

frequencies originating from the different components. 

One of the many advantages is that you can collect hours of time waveform data, then 

pick out only the few minutes of interest. ibaRotate is fast, and provides the following 

analysis functions. 

Tachometer analysis processes a machine speed signal (pulsed or DC voltage) to 

create the instantaneous machine speed curve in RPM. 

Waterfall analysis computes and displays multiple spectra over time in a traditional 3D 

Waterfall plot or Color Contour plot. 

Computed Order Tracking shows you the magnitude and phase change for multiple 

orders over time in a Bode plot. 

Vold Kalman Filter extracts multiple orders as modulated time histories as well as the 

real and imaginary parts of the complex envelopes of the orders. The time resolution of 

the results is the same as the resolution of the outputs. 

Torsional vibration analysis creates an accurate kinematic description of torsional 

vibrations from a single tachometer or other machine speed signal. 

Advanced plotting features such as sophisticated cursors simplify identifying the 

spectral peaks in Waterfall and Contour plots. 

Bearing, Gearbox, and Sideband Cursors 

ibaRotate includes three additional cursors. For more information on plotting features, 

refer to chapter 5, "ibaRotate Plotting Features". 

The Rolling Element Bearing cursor displays up to six cursors to help you identify peaks 

caused by individual components of a bearing. 

The Gearbox cursor displays up to eight cursors based on the number of input and output 

gear teeth to help you identify peaks caused by gears. 

The Planetary Gearbox cursor displays up to 11 cursors based on the number of gear 

teeth to help you identify peaks caused by planetary gears. 

The Sideband cursor displays a user-defined number of sideband cursors to help you 

identify sideband frequencies around a primary frequency. 
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Order Normalization 

ibaRotate can resample a time waveform to order normalize the data when performing 

a Waterfall analysis. Order normalization cancels the effect of frequency smearing across 

spectral bins when the shaft speed is changing rapidly (high slew rate). It ensures that 

order-related peaks are aligned with the orders when plotted against the orders. 

A specification of order range enables the user to generate data for the selected order 

band, i.e., an order domain zoom. 

Millstrum Analysis 

Millstrum analysis simplifies the process of identifying families of harmonics and 

sidebands. Millstrum analysis does this by removing non-repetitive events and 

presenting the results in an easily understood format. It is similar to using the cepstrum, 

but goes further in simplifying the results so that you do not have to perform any 

additional calculations. 

RPM from Waterfall Analysis 

The RPM from Waterfall analysis enables you to determine the machine speed from a 

Waterfall analysis. Even though you do not have a tachometer signal, you can create the 

smoothed machine speed curve that describes the instantaneous speed of the machine 

over time. 

Preprocessing 

The Preprocessing function enables you to create a new time waveform by sampling 

existing time waveforms at a different rate. Also high and low pass filter can be assigned 

to the time waveform, linear trends can be removed, scales and offsets can be set and 

the spectrum type can be changed by integration or differentiation. 

Combinations of two Signals 

This option enables you to scale two time histories, then to add, multiply, divide and 

subtract them. Example uses are for crankshaft twist and decoupling rotation from 

translation. 

Window Correction (Hilbert Peak) 

Hilbert Peak enables you to perform a phase modulation in a band around a tooth pass 

order to extract the speed variations of a gear in the order domain. This feature only 

works for gears/encoders with a uniform distribution of teeth, but is often a good torsional 

analysis tool when the sampling rate is limited, e.g. to four times the tooth pass 

frequency. 

Synchronous Averaging 

This feature re-samples to the angle domain, and produces a waterfall where the X-axis 

is two revolutions, i.e., 720 degrees, and the amplitude is the amplitude of the time 

history. If averaging is specified, the segments will all start at the same angular position, 

so that non-period features will be averaged out, and only the systematic features 

remain. 

This enables the user to inspect the kinematics of a machine/engine as a function of 

shaft angle, and is very useful for identifying features in systems such as valve trains 

and fuel supply. Only the order components in the specified order range will be used, so 

that this also enables for a zoom in the order domain. 
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2.2 File Import Add-on License 

File Import of time waveform data from many sources 

With this add-on license, you can read time history data from a variety of legacy formats, 

including Teac, Sony, HP-SDF, Zonic Medallion, Vibe-Tech, ASCII, WAV, MATLAB, 

Dactron, UFF, MEGADAC, Nicolet Prism, Nicolet NRF, STAC Rex, SoMat Ease, and 

DSPCon data files. 

If you have the ME’scope™ program from Vibrant Technology, you can export computed 

order tracking data to ME’scope for operating deflection shape analysis. 

 

2.3 ibaRotate User Interface 

ibaRotate follows the standard Windows® user interface standards, and consists of the 

usual windows, menus, and toolbars. The ibaRotate Main Window is shown in the figure 

below: 

 

Figure 1: ibaRotate Main Window with no signals added yet. 

 

 The menu bar appears directly below the title bar. It contains the menus of 

commands for the program.  

 The toolbar appears directly below the menu bar. It contains the tool buttons that 

are shortcuts to the frequently used functions of the program. A short tooltip 

describing the button function appears when you move the mouse pointer over a 

button. You can also show or hide any toolbar with the commands on the View 

menu. The figure below shows the functions associated with all the buttons on the 

toolbar. 
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Icon Description Icon Description 

 

Copy the selected data values 
to clipboard  

Setup and perform waterfall analysis 

 

Print and preview active 
window  

Setup and perform computed order 
tracking analysis 

 

Change the printer and 
printing options  

Setup and perform Vold Kalman 
filter analysis. 

 

Print the active window 

 

Play / Pause data signal using 
computer sound card 

 

Arrange plot windows so they 
overlap  

Add data file to project 

 

Arrange windows as non-
overlapping tiles stacked 
vertically 

 

Remove selected signal(s) from 
project 

 

Arrange windows as non-
overlapping tiles stacked side 
to side. 

 

Plot the selected signal 

 

Setup and perform 
Tachometer Processing  

Show/Hide signals list window 

Figure 2: Toolbar icon functional descriptions 

 The plot workspace area holds the 2D and 3D plot windows. 

 The status bar appears directly below the plot workspace and shows a brief 

description of the current command or button under the mouse pointer. 

 The signal list region shows the signals (tachometer and data) that you have 

imported into, or created in, ibaRotate. To toggle signal list window display 

show/hide, use the toolbar button or select “View - Signal List” in the menu bar. 

 

 

Figure 3: Signal list window with two signals and computed results (left) and plot window with 
time history and Waterfall plots (right) 
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ibaRotate provides access to many functions by using the right-click menus. These 

menus can be accessed by right-clicking on items in the signal list region or by right-

clicking on the individual plot windows that appear in the plot workspace. These options 

are described throughout this manual. 

2.4 License information 

Order no. Name Description 

33.010500 ibaRotate Analysis tool 

33.010501 ibaRotate-Add-on non-iba files Reading external data 

33.010510 ibaRotate-EUP Extended upgrade period 

61.000600 T_ibaRotate 2-day basic course 

 

Product upgrade 

The purchase of an ibaRotate license includes free product updates for a period of two 

years from the purchase date. 

By purchasing the product “Extended update period (EUP)”, ibaRotate users are entitled 

to update ibaRotate for another year in order to benefit from continuous improvements 

and new features. An EUP extension is always valid from the date the previous update 

period expires. 
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3 ibaRotate Quick Start Tutorial 

This chapter leads you through several simple steps to import and process actual 

measurement data and generate Waterfall plots in both the frequency domain and the 

order domain.  

This short tutorial introduces you to the basic functions of ibaRotate. After you have 

completed this chapter, you will be able to perform the steps to import and begin to 

analyze your data in ibaRotate. 

This tutorial uses a demonstration data file that is automatically provided with ibaRotate: 

Demo_Data.dat. This should be located in the same installation folder where 

ibaRotate.exe has been installed. 

3.1 Start ibaRotate 

1. To start ibaRotate on a Microsoft Windows machine, click the <Start> button, select 

“Programs – iba - ibaRotate” 

2. The ibaRotate program window appears (see Figure 4). 

3. To stop ibaRotate: choose “File - Exit”, or click the window close button in the upper 

right corner, or type <Alt> + <F4>. 

The signal list window is shown on the left side of the main window in Figure 4.  

This signal list is currently empty, but your signal list may contain signals which ibaRotate 

remembers from your previous ibaRotate session. 

Adding/removing signals is simple and quick in ibaRotate, to enable you to quickly plot 

and process your data. Adding data signals is described below. 

 

Figure 4: ibaRotate Main Window with empty signal list window 

Plot 

Workspace 
Signal List 

Region 
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3.2 Set Your Preferences 

The preferences settings control the default ibaRotate appearance and functions. To set 

your preferences, follow these steps: 

1. From the “Edit” menu choose “Preferences”. 

 

Figure 5: Preferences Dialog Window 

 

2. In the „Preferences“ dialog window, select or enter the desired defaults. Choose 

<OK> when finished. 

 Frequency units in plots 

 Waterfall plot type (waterfall or contour) 

 Plot default name is the name used for plot configuration files automatically stored 

in the installation directory, and retrieved in subsequent ibaRotate sessions. 

 Default sampling frequency, which defines time increment for imported data, 

which may not have a time increment. 

 AC coupling removes static offsets in measurement signals. 

 Automatic plot display after analysis. 

 Short UFF channel names when exporting signals to Universal files. 

 Creation of Torsional analysis files when processing a tachometer signal 

 Enable glitch filter on counter channels for counter type tachometer files. 
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 Results Directory = directory for the files created by the ibaRotate analysis 

functions, which is usually a different location than the original source data, to avoid 

any confusion between original test data and calculated results. 

 

3.3 Add a File to the Signal List Window 

Add the demo file “Demo_Data.dat” to the signal list window. This opens the file, scans 

the file, and adds the filename and signal names to the signal list window. ibaRotate can 

add signals from many different file formats. 

1. From the “Signals” menu, select “Add Files”. A dialog window, shown in Figure 6, 

will appear. 

2. If you are not using iba files (*.dat), select the correct “Type of File”. If you do not 

know the file type, select „All Files (*.*)“.  

 

 

Figure 6: Add Files Dialog Box 

 

3. Select the „Demo_Data.dat“ file and click <Open>. The data file along with its 

signals will appear in the signal list. 

 

 

Four ways to add a file:  

 From the “File” menu, choose “Add File”.  

 From the “Signals” menu, choose “Add File”.  

 Click the <Add File> button in the toolbar. 

 Right-click in the signal list window and select “Add Files…”  
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3.4  View the Signal List and Signal Properties 

 

Figure 7: Signal list window with 2 signals added 

 

The “Demo_Data.dat” file contains two time waveform signals: 

 Channel 1 is a pulse tachometer signal varying between 0 and 4 Volts. 

 Channel 2 is a vibration sensor (accelerometer) signal. 

 

Check the properties of a signal by right-clicking on the signal and selecting “Properties”, 

to bring up the “Signal Properties” box shown in Figure 8.  

 

Figure 8: Right-click on a signal and select “Properties” to list signal properties 
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You can hide the signal list window by several methods: 

 press <Ctrl> + <L>  

 click on the small “x” in the upper right corner of the signal list window  

 grab the drag bar (the double lines at the top of the signal list) and drag the window 

somewhere away from the ibaRotate window 

 click the <Signal List> button in the toolbar  

 choose “Signal List” in the “View” menu  

 

You can restore the signal list window by: 

 press <Ctrl> + <L> 

 click the <Signal List> button in the toolbar 

 choose “Signal List” in the “View” menu  
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3.5 Plot a Time Waveform Signal 

The quickest way to plot a signal is to just double-click it. Double-click Channel 1 (the 

pulse tachometer signal) to bring up a plot similar to Figure 9. (If you do not see the 

signals, click on the + marker to the left of the data file entry to display its signals within 

the file.) 

 

 

You can also do one of the following to plot a signal: 

 Select (left-click) the signal and click the <Plot> button on the toolbar. 

 Select the signal and choose “Plot” from the “Signals” menu. 

 Right-click the signal and select “Plot” from the pop-up menu. 

 

 

Figure 9: Plot of Channel 1 Demo Data 

Channel 1 is shown in the top splitter window and the bottom main plot. These plots are 

first drawn with one cursor by default, at the left of the main plot, and center of the top 

plot. 

There are numerous tools for you to interact with these plots to understand your data. 

Several things you can do: 

 Left-click and hold down anywhere on a plot and you will see the cursor jump to that 

location. The cursor x-y values are shown. On the lower plot: move the cursor left or 

right and you’ll see the upper plot window follow the cursor. 

 Left-click and hold on the “splitter-bar” between the two plots, and move up and 

down to resize the plots, or hide either window altogether. 

 Right-click on either plot to bring up a pop-up menu with numerous options to 

modify the plots. The “Zoom” option is demonstrated in the next section. 

These plots are shown with the “silver theme” color scheme. To select a color scheme: 

right click on a plot, select “Properties” from the pop-up menu, select the “Scheme” tab, 

and select the desired color scheme. 
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3.6 Zoom in on the Time Waveform 

1. Right-click on the main plot and choose “Zoom” as shown in Figure 10. 

2. Left-click and drag the mouse over a part of the plot to enlarge that part of the plot. 

 

Figure 10: Zoom of Channel 1 Demo Data 

 

3. The plot redraws itself to the selected area when you release the mouse button and 

will look similar to Figure 11. Note the signal amplitude is from -0.5 to 4 Volts. 

 

Figure 11: Zoomed area of Channel 1 

 

4. Right-click the plot and choose “Auto-scale” to show the whole signal again. 
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3.7 Generate a Waterfall Plot of the Accelerometer Signal 

A waterfall is a powerful tool to display a signal – to display the changing spectra over 

time. Steps to calculate spectra and plot the waterfall for a time waveform are: 

1. Select Channel 2 (the accelerometer signal) in the signal list window. 

2. With Channel 2 selected, click the <Waterfall Processing> button on the toolbar. 

You can also choose the “Waterfall Processing” command from the “Analysis” 

menu. 

3. Select a blocksize of 2048, and about 100 spectra. Choose <OK> to process the 

accelerometer signal and generate a Waterfall plot. 

 

Figure 12: Waterfall Processing Options 

 

4. ibaRotate displays the acceleration waterfall, and the slice at the cursor:  

 

Figure 13: Waterfall Showing Full Frequency & Time Ranges 
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Right-click on the waterfall and select “Zoom” to zoom in on the region of interest. The 

zoom cursor is shown in Figure 14 for the region 20 – 90 sec, and 0 – 600 Hz.  

 

 

Figure 14: ”Zoom” cursor defines frequency & time ranges for region of interest 

 

The zoomed waterfall in Figure 15 shows the ridges more clearly. These ridges 

correspond to orders of the machine speed. The tachometer will be processed and used 

to identify the orders in the following sections of this tutorial. 

 

 

Figure 15: Zoomed Waterfall Showing Ridges Clearly 
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3.8 Process a Pulse Tachometer Signal 

ibaRotate has capabilities to process many types of tachometer signals to calculate 

machine speed profiles (histories). ibaRotate uses the speed profiles for numerous 

advanced processing techniques, such as order normalization and order tracking. 

Steps to process a pulse tachometer signal to calculate the instantaneous machine 

speed history in RPM (revolutions per minute) are: 

1. Select (left-click) Channel 1 (the tachometer signal) in the signal list window. 

2. With Channel 1 selected, click the <Tachometer Processing> button on the toolbar. 

You can also choose the “Tachometer Processing” command from the “Analysis” 

menu. 

3. Make sure the trigger level is between 1 and 4 Volts. In general, the trigger level 

should be in the middle of the amplitude of the tachometer signal for a pulse 

tachometer. Choose <OK> to process the tachometer signal. 

 

Figure 16: Tachometer Processing Options 

 

4. ibaRotate displays a plot of the machine RPM as shown in Figure 17. There are 

actually two curves on the plot. One line is the smoothed (spline-fit) RPM curve. 

The other line is the Raw RPM curve before ibaRotate applied the spline-fit to 

smooth the RPM curve.  

 

Figure 17: Tachometer processing results = machine speed vs. time 
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5. Zoom in on the peak of the RPM curve to see the two curves. Right-click the plot, 

choose “Zoom”, then click and drag over the region you want to zoom. An example 

is shown in Figure 18. 

 

 

Figure 18: Zoomed area of tachometer processed data 

 

The smoother curve (green) is the spline-fit RPM curve, while the rougher curve (blue) 

is the raw RPM curve before smoothing. 

There will be two new generated data signals in the signal list, each listed as a distinct 

item under the original data signal entry “Channel 1” (shown in Figure 19). When the 

tachometer speed histories are created, ibaRotate also saves these new histories into 

files in the “Results” directory (defined on the Edit/Preferences dialog box). The newly 

created data files will be named as “Demo_Data0.spl” and “Demo_Data0.raw”. The 

former file is the smooth (spline-fit) RPM data and the latter is the raw RPM data. 

 

Figure 19: Signal list window contains data from tachometer processing 
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3.9 Add Smooth Speed Profile to Waterfall to make a “Smart 
Waterfall” 

The waterfall in section 3.7 was plotted in the frequency domain. However, the machine 

speed changed over the test. The frequency of the orders changed with the speed profile. 

ibaRotate enables converting the waterfall to the order domain easily: 

1. Plot the waterfall from section 3.7 (double-click on the waterfall icon for Channel 2). 

2. Left-click on the “smoothed RPM Channel 1” in the signal list, and drag the cursor 

over to the waterfall and release (see Figure 20). The smoothed speed profile has 

been added to the waterfall, so now the waterfall can be plotted in the order 

domain. 

 

Figure 20: Slide the “Smooth RPM” from signal list to Waterfall to add Speed data to the 
Waterfall 

3. Right-click on the waterfall, select “Properties”, select “X-axis”, and select „units = 

orders“. In the „Properties“ dialog box, select the “cursor” tab and change the cursor 

from Hz to orders. Zoom in on the plot region up to the first 12 orders, as shown in 

Figure 21. 
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Figure 21: Waterfall Plotted in the Order Domain 

 

3.10 Other Types of Analyses 

You can perform many other types of analyses in ibaRotate to assist in diagnosing a 

variety of difficult problems. 

Refer to chapter 4 for more information on the different types of analyses and their uses. 

3.11 Manage Files 

ibaRotate can generate a large number of files during an analysis. Managing your files 

in a logical manner can make it much easier to keep the generated files with the original 

data files and to delete files that you no longer need. 

The easiest way to manage files in ibaRotate is to use a separate directory for each set 

of original data files. Then you can create a new directory for each set of analyses. Or, 

you could use the same directory for all your analysis if you delete all the files after you 

are done. 

1. Create a directory for the project; the directory must have read/write permissions for 

the project directory (if on a network). 

2. Copy your original data files for the analysis into the project directory. 

3. From the “Edit” menu in ibaRotate, choose “Preferences”. 

4. Edit the „Results“ directory so that it is the project directory or a sub-directory of the 

project directory. Click <Browse> to select the „Results“ directory. 

5. Perform the analysis. ibaRotate stores the generated files in the „Results“ directory. 

This makes it easy to keep all the files for a project together. 

6. When you are done with your analysis, you can delete the generated files if you do 

not want to keep them. 
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4 ibaRotate Applications 

This chapter describes the analysis methods available in ibaRotate. The chapter begins 

with some notes on collecting data. It then lists some uses for each method, then goes 

on to present a sample application of the method. 

You can use this chapter as a guide to selecting the best method to analyze data for a 

particular type of problem. However, this chapter is not meant to be the last word on 

analysis using ibaRotate. You are likely to discover other applications for ibaRotate after 

you have been using it for a while. 

4.1 Notes on Collecting Data 

4.1.1 Sample Rate 

Guidelines for the sample rate for each type of application are described under the 

application. One thing to note is that the sample rate of the tachometer signal does not 

have to be the same as the sample rate for a data signal. For example, the sampling rate 

on the tachometer signal can be much higher than the sampling rate on a vibration 

transducer signal. 

In general, the sampling rate must be at least ~2.5 times the maximum frequency of 

interest to avoid aliasing effects (described below). Note that most analyzers require that 

you use the sample rate, not the maximum frequency, in setting up to collect time 

waveform data. So for a maximum frequency of 400 Hz, set the sampling rate at 1,000 

samples/second. 

 

 

4.1.2 Aliasing 

Aliasing is an artifact of collecting data caused by using a sampling rate that is less than 

twice as high as the highest frequency sampled. Aliasing results in extra spectral peaks 

from higher frequencies that get “folded back” by the signal processing. Most data 

collection instruments use a low pass filter, called an anti-aliasing filter, to exclude 

frequencies that would cause aliasing. 

Some instruments that can capture a time waveform signal do not include anti-aliasing 

filters. When using this type of equipment, you must be careful when analyzing spectra, 

since there may be extra spectral peaks due to aliasing. 

Figure 22 shows a Waterfall plot with aliasing. This torque data was collected without 

anti-aliasing filtering. In this plot, speed is increasing, as you can see by the rising 

frequency in the cursored spectral peaks. However, there are several sets of peaks that 

appear to be decreasing as speed increases. These are due to alias frequencies “folding 

back”. 

400 Hz
1000

2.5
------------

Sampling rate

2.5
---------------------------------=

400 Hz 2.5 1000 Sampling rate=
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Figure 22: Waterfall plot of aliasing effects 

 

4.2 Processing a Tachometer Signal 

ibaRotate can process a tachometer or other machine speed signal to create a RPM 

curve that describes the instantaneous speed of the machine over time. The machine 

speed signal can be either a pulse or a DC-voltage level signal from a tachometer, 

encoder, or other speed sensor. 

You can use the speed curve to diagnose some problems directly. You can also use the 

speed curve along with other data, such as vibration, as an input for additional 

sophisticated ibaRotate analysis techniques. Finally, you can create a torsion file when 

processing a tachometer signal. See “Torsional Analysis” in section 4.7. 

4.2.1 Applications 

Processing the tachometer signal results in an RPM curve describing the instantaneous 

machine speed. ibaRotate uses a spline-fit process to create a smoothed speed curve 

from the tachometer signal. The speed curve is a high-resolution view of the machine 

speed. 

You can use this smooth speed curve to diagnose problems related to the speed or 

speed change of a machine. This provides an independent verification of the machine 

speed, since some process control indicators suffer from “flat spots” in their response to 

speed changes. 

Other applications include the following: 

 Examining the effects of changing load or other process dynamic on the speed. 

 Determining the effect of power fluctuations (brownouts) on the speed. 

 Speed profiling on a multi-drive machine to determine if there slip at any of the drive 

units (over- or under- speed). 

 Threading analysis on a sheet mill. 

 Evaluating the actual machine speed against the ideal constant speed. 
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 Verification of the speed change between two points to determine the elongation of 

the material such as in a rolling mill. 

 Examination of the speed curve to diagnose speed oscillation due to a loose 

coupling, hunting motor or other cause. 

4.2.2 Input Signal Requirements 

The input signal to the tachometer analysis is a tachometer or other machine speed 

signal. As with all analysis techniques, the better the input signal, the clearer the results 

— so a good, clean tachometer signal is essential. 

For a pulsed tachometer signal (non-contact probe, encoder, etc.) the sampling rate must 

be at least 2.5 times the maximum frequency of interest to avoid aliasing effects. A good 

rule of thumb is to use 5–10 time over-sampling of the tachometer pulse frequency (not 

the machine speed) to get good, clean tachometer pulses. For example, if a tachometer 

produces one pulse per revolution on a 600 RPM machine, sample the tachometer data 

at a rate of 50–100 samples/second (Hz). 

 

 

For a DC voltage tachometer signal, you must know the machine speed when the signal 

is at 0 volts. For some sensors, the DC speed signal falls to 0 volts before the machine 

is at a standstill. 

4.2.3 Example 

The following example is taken from a rolling mill. As the sheet of metal is rolled out, the 

speed of the sheet increases. This produces a distinctive speed profile, as shown in the 

data collected from several stands along the mill. 

This plot is the raw DC tachometer signal. 

 

Figure 23: Raw Tachometer Signal 

 

600 RPM
1 minute

60 seconds
-------------------------- 5 50 samples/second=
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1. The first step is to process the tachometer signal to create a smoothed speed 

curve. For the steps to process a tachometer signal, see “Process a Pulse 

Tachometer Signal” in section 3.8. 

 

 

Figure 24: Processed Tachometer Signal 

 

2. Repeat the first step to get smoothed speed curves for each stand. 

3. Overlay the speed curves from different stands to see the speed profile for the 

machine. You can overlay multiple speed curves by selecting them in the signal list 

window then clicking the <Plot> button. 

 

Figure 25: Multi-processed Tachometer Signal 
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4.2.4 Theory 

ibaRotate uses a spline-curve fit algorithm that computes raw or initial estimates of a 

machine's instantaneous rotating speed by utilizing sampled analog data from the 

sensor. With pulse tachometer data, ibaRotate computes an initial estimate by measuring 

the time between pulses. Next, it uses a series of cubic splines that enforce continuity at 

their boundaries to create a smooth estimate of the machine's rotating speed. 

ibaRotate then uses a unique technology to remove the “outliers” from the raw estimate 

before re-evaluating the spline fit. This enables you to use noisy tachometer signals or 

tachometer signals with dropouts. In some cases, this can delay the need to repair or 

replace the tachometer. 

 

4.3 Waterfall Analysis 

You can perform a Waterfall analysis on time waveform data from any transducer. The 

data transducer can be a vibration sensor (accelerometer, velocity sensor, non-contact 

probe) or any other meaningful sensor (thickness, pressure, etc.). 

You can use Waterfall analysis on a data signal without a machine speed signal; 

however, you will not be able to use the machine speed or order tracking capabilities of 

the Waterfall plot. If you have a tachometer signal you can create the smooth speed 

curve as described in “Processing a Tachometer Signal” earlier in this chapter. Then you 

can combine the speed curve with data from a correlated transducer in the Waterfall 

analysis. 

The result of the Waterfall analysis is a series of spectra displayed on a three-

dimensional (X-Y-Z) plot. The Waterfall plot provides several useful ways of looking at 

the data: 

 The plot cursors can track the X-axis or the Z-axis. 

 You can choose frequency or orders for the X-axis and X-axis cursors. 

 You can choose spectrum number, RPM, or seconds for the Z-axis and Z-axis 

cursors. If you use order normalization, you can also choose the number of 

revolutions for the Z-axis. 

 You can display the data in a traditional spectral Waterfall plot, or as a Color 

Contour plot. See “Contour Plot”. 

 ibaRotate can also order normalize the data so that the order-related peaks line up 

exactly on the orders (when the X-axis is in orders). See “Order Normalization” in 

section 2.1. 

4.3.1 Applications 

The ibaRotate Waterfall plot is ideal for non-steady state processes such as variable 

speed machinery. The plot shows you the change in the appearance of the spectra over 

time. This is particularly useful in the following applications: 

 Analyzing the machine’s behavior during run-up or coast-down. 

 Diagnosing amplitude modulation (“beat”). 

 Determining the frequency and severity of resonances, such as shaft critical 

speeds. 

 Analyzing a machine’s response to speed or load variations. 
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 Isolating non-varying spectral peaks (such as those caused by electric power or 

resonance) from speed-dependent peaks (such as vibration). 

 Isolating spectral peaks from other processes that are linked to the machine. 

 Ruling out spurious spectral peaks caused by aliasing when using time-capture 

equipment that does not have anti-aliasing filtering. See “Aliasing” in section 4.1.2. 

 Performing Waterfall analysis directly on a DC speed signal to diagnose torsional 

problems. For more on torsional analysis, see “Torsional Analysis” in section 4.7. 

4.3.2 Input Signal Requirements 

ibaRotate Waterfall analysis requires a smoothed speed curve from performing a 

Tachometer analysis if you want to use the order tracking features of the Waterfall plot. 

When collecting the non-tachometer data (vibration, temperature, etc.), note the 

following: 

 If you want to see low frequency data in the Waterfall analysis, make sure that the 

high pass filter setting in your analyzer is not excluding the desired low frequencies. 

 The sample rate in the analyzer must be at least 2.5 times the maximum frequency 

of interest to avoid aliasing. 

 The choice of window function for analysis depends on the type of resolution you 

need (amplitude or frequency resolution). 

4.3.3 Example 

The following example is from a rolling mill. 

1. Process the tachometer signal to get the smoothed speed curve. See “Process a 

Tachometer Signal” in section 3.8. If you do not have a tachometer signal, skip this 

step. 

 

Figure 26: Rolling mill processed Tachometer Signal 
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2. Use Waterfall analysis to create the Waterfall plot. To use the order tracking 

features, select both the smoothed machine speed curve and the data signal in the 

signal list window. If you do not have a tachometer signal, simply select the data 

signal. Then do one of the following: 

 Click the <Waterfall analysis> button. 

 Choose “Waterfall Analysis” from the “Analysis” menu. 

 

Figure 27: Waterfall Analysis 

 

3. After selecting the desired parameters, choose <OK> to display the Waterfall plot. 
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Figure 28: Rolling Mill Pinion Noise 

4.3.4 Theory 

The ibaRotate Waterfall analysis uses the standard Fast Fourier Transform to calculate 

the array of FFT spectra and then display them in a Waterfall or Color Contour plot 

(spectrogram). The spectrum calculation enables for standard parameters such as 

blocksize, averaging, windowing, weighting (A, B, and C), frequency domain integration, 

and integration/differentiation functions as found on most spectrum analyzers. ibaRotate 

can display spectra as a function of either time or RPM. 

 

4.4 RPM from Waterfall 

The RPM from Waterfall function in ibaRotate enables you to determine the machine 

speed from a waterfall file. If you do not have a tachometer signal, or the signal is 

extremely noisy, you can use other data to create an RPM curve that describes the speed 

of the machine over time. 

ibaRotate can use this smoothed speed curve in the same ways as a speed curve 

generated from a tachometer signal. You can use this speed curve to diagnose some 

problems directly. You can also use the speed curve along with other data, such as 

vibration, as an input for additional sophisticated ibaRotate analysis techniques. 

4.4.1 Applications 

The RPM from Waterfall function is applicable when you have a time waveform from a 

data signal, but no tachometer signal or a noisy signal. There may not be a tachometer 

available, or it may be impractical to use a tachometer or another speed sensor on the 

machine. In some cases, the RPM from Waterfall function may produce a better speed 

curve than a tachometer. 



ibaRotate Manual  

 

 
Issue 1.0 37 

 

4.4.2 Input 

When collecting the non-tachometer data (vibration, temperature, etc.), note the 

following: 

 If you want to see low frequency data in the Waterfall analysis, make sure that the 

high pass filter setting in your analyzer is not excluding the desired low frequencies. 

 The sample rate in the analyzer must be at least 2.5 times the maximum frequency 

of interest to avoid aliasing. 

 The choice of window function for analysis depends on the type of resolution you 

need (amplitude or frequency resolution). Since the RPM from Waterfall function 

depends more on the position of the spectral peaks than on the amplitude, the 

Hamming window is a good default choice. 

4.4.3 Example 

This example uses the “RPMFromWaterfallDemo.wat” file included with ibaRotate. You 

can also use any waterfall file generated by ibaRotate using Waterfall analysis (see 

“Waterfall Analysis” in section 4.3). 

 In the signal list window select the “RPMFromWaterfallDemo.wat” file, and then 

select the waterfall signal. You can display the Waterfall by clicking on the <Plot> 

button. 

 

Figure 29: Waterfall plot from demo file 

 From the “Analysis” menu, choose “RPM from Waterfall”. This displays a color 

contour plot of the waterfall. 
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Figure 30: RPM from Waterfall dialog window 

 

 Enter the order you want to use to find the machine speed. For this example, leave 

the value at 35 for the 35th order. 

 Right click on the contour plot and select “Zoom”. Zoom in on the area around the 

35th order. 

 

 

Figure 31: Zoom of contour on RPM from waterfall dialog window 

 

 Working from the bottom of the plot to the top, click the peaks for the order. 

ibaRotate draws a line for the order by estimating the location of the order. You can 

change the location of the line by clicking on the plot. 
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Figure 32: Order selection line on contour plot in the RPM from waterfall dialog window 

 

 If you want to start over, simply choose <Cancel>. 

 When the line on the plot connects the peaks for the order, click <OK>. ibaRotate 

calculates a smoothed machine speed curve based on the order number and the 

line on the plot. 

 

Figure 33: Smoothed speed curve from Waterfall plot 

 You can select the smoothed speed curve and the waterfall data in the signal list 

window, and then click the <Plot> button to display the Waterfall. This enables you 

to use the order tracking features of the Waterfall plot. 
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4.4.4 Theory 

The RPM from Waterfall function uses the assumption that an order of running speed 

generates a distinct series of peaks in a Waterfall plot. After you identify the peaks for 

the order, ibaRotate determines the RPM versus time function and generates a smooth 

RPM curve of the instantaneous speed. 

 

4.5 Computed Order Tracking 

Computed Order Tracking uses the smooth speed curve from processing a tachometer 

signal or from the RPM from Waterfall function. You can combine the speed curve with 

data from a correlated transducer to perform a Computed Order Tracking analysis. The 

correlated transducer can be a vibration sensor (accelerometer, velocity sensor, non-

contact probe) or any other meaningful sensor (thickness, pressure, etc.). 

4.5.1 Applications 

Computed Order Tracking shows you the amplitude and phase of the data at selected 

orders, plotted against the machine's speed. Computed Order Tracking is ideal for 

variable speed machinery. This is particularly useful in the following applications: 

 Analyzing of the machine’s behavior during run-up or coast-dow 

 Analyzing of a machine’s response to speed or load variations 

 Determining the frequency and severity of resonances, such as shaft critical 

speeds, even when the resonances are heavily dampe 

 Balancing rotor 

 Generating operating deflection shapes. 

4.5.2 Input Signal Requirements 

ibaRotate Computed Order Tracking requires a smooth speed curve from processing a 

tachometer signal or using the RPM from Waterfall function. ibaRotate processes the 

machine speed with the transducer data to create the plot of the orders. When collecting 

the non-tachometer data (vibration, pressure, etc.), note the following: 

 If you want to see low frequency data in the Order Track plot, make sure that the 

high pass filter setting in your analyzer is not excluding the desired low frequencies. 

 The sample rate in the analyzer must be at least 2.5 times the maximum frequency 

of interest to avoid aliasing. Be aware that the anti-aliasing filter in many data 

collection instruments truncates the upper 20-30% of the frequency range (the 

highest orders in the signal). 

 The choice of window function for analysis depends on the type of resolution you 

need (amplitude or frequency resolution). 

4.5.3 Example 

This example is from the demonstration data included with ibaRotate. 

1. Process the tachometer signal to get the smoothed speed curve. See “Process a 

Pulse Tachometer Signal” in section 3.8. 

2. Then use Computed Order Tracking to get the order data. Select both the 

smoothed machine speed curve and the data signal in the signal list window, then 

do one of the following: 
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 Click the <Computed Order Tracking> button. 

 Choose “Computed Order Tracking” from the “Analysis” menu. 

 

Figure 34: Computer Order Tracking dialog window 

 

3. After selecting the desired parameters, choose <OK> to display the Bode plot of the 

orders similar to the one shown in Figure 35. 

 

Figure 35: Channel 2 Computed Order Tracking from demo data 

4.5.4 Theory 

The order functions created by the Computed Order Tracking function are leakage free 

because the instantaneous machine speed controls the re-sampling in the Computed 

Order Tracking algorithm. Computed Order Track plots are created from many more data 

points than the orders plotted in a Waterfall, and are a more precise picture of each order. 
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4.6 Vold-Kalman Filter 

The Vold-Kalman Order Tracking Filter (VKF) enables high performance simultaneous 

tracking of orders as both modulated waveforms and as complex order envelopes. The 

Vold-Kalman Filter uses the smooth speed curve from processing a tachometer signal 

or from the RPM from Waterfall function. You can combine the speed curve with data 

from a correlated transducer to perform a Vold-Kalman Filter analysis. The correlated 

transducer can be a vibration sensor (accelerometer, velocity sensor, non-contact probe) 

or any other meaningful sensor (thickness, pressure, etc.).  

4.6.1 Applications 

Vold-Kalman Order Tracking Filter shows you the time histories of selected orders. This 

method is ideal for rapidly changing machinery speed. This is particularly useful in the 

following applications: 

 Separating drive shaft orders from wheel orders in suspension tuning 

 Decoupling in acoustics applications 

 Tracking events in transmissions even through radical RPM changes 

 Multiplane balancing 

 Measurements of operational deflection shapes and sine sweep transfer functions 

(must be exported to post processing software such as ME'scope) 

 Input Signal Requirements 

ibaRotate VKF requires a smooth speed curve from processing a tachometer signal or 

using the RPM from Waterfall function. ibaRotate processes the machine speed with the 

transducer data to create the plot of the orders.  

4.6.2 Example 

This example is from the demonstration data included with ibaRotate. 

1. Process the tachometer signal to get the smoothed speed curve. See “Processing a 

Pulse Tachometer Signal” in section 3.8. 

2. Select a smoothed machine speed curve and a data signal in the signal list window. 

3. Click the <Vold-Kalman Analysis> button or choose “VKF Analysis” from the 

“Analysis” menu. 
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Figure 36: Vold-Kalman Filter settings window 

 

4. After selecting the desired parameters (bandwidth = 0.1, Orders = {1, 2, 9}, 2 Pole 

Filter), Complex envelope and Order time history, choose <OK> to display the plot 

of the „complex envelope“ of the selected orders. 

 

Figure 37: Complex envelopes by Vold-Kalman filter 

5. We can also plot the generated time histories of the orders 
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Figure 38: VKF output showing 1st and 9th orders as time histories 

4.6.3 Theory 

The order functions created by the Vold-Kalman Filter function have no phase bias and 

no leakage because the instantaneous machine speed controls the tracking filter 

algorithm in a time symmetric formulation. There is also no slew rate limitation, so this 

filter is exceedingly agile. There are now numerous applications for this filter in signal 

editing, sound quality, sine sweep testing and machinery diagnostics.  

 

4.7 Torsional Analysis 

ibaRotate can process a tachometer or other machine speed signal to create an accurate 

kinematic description of torsional vibrations from a single measurement. The machine 

speed signal must be a pulsed signal from a tachometer, encoder, or other speed sensor 

that shows torsional changes. 

 

 

Note 

Torsional analysis creates a time history of the machine speed, similar to that from a 

high-resolution DC speed sensor. If you have a high-resolution DC speed signal, you 

can simply perform a Waterfall analysis on the speed signal to view the torsional 

vibration. See “Waterfall Analysis” in section 4.3. 

 

Torsional analysis results in a time history of instantaneous shaft speed with even sample 

spacing in time (in revolutions per second). You can then use Waterfall analysis of the 

torsion file to create a series of spectra displayed on a three-dimensional (X-Y-Z) plot. 

The Waterfall plot provides several useful ways of looking at the data: 

 The plot cursors can track the X-axis or the Z-axis. 

 You can choose frequency or orders for the X-axis and X-axis cursors. 

 You can choose spectrum number, RPM, or seconds for the Z-axis and Z-axis 

cursors. 
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 You can display the data in a traditional spectral Waterfall plot, or as a Color 

Contour plot. See “Contour Plot” in section 5.5. 

 You can use the torsional Waterfall plot to diagnose a variety of problems directly 

from the machine speed signal. In some cases, ibaRotate can eliminate the need 

for slip rings, telemetry and torsional transducers. 

4.7.1 Applications 

Torsional analysis is useful in diagnosing any problems arising from torsional vibration 

(variations in rotational speed of a component due to twisting). This technique can 

identify problems that do not usually appear in conventional vibration measurement and 

analysis. This is particularly useful in the following applications: 

 Finding shaft critical speeds in turbines 

 Identifying torsional resonances in internal combustion engines that reduce the 

efficiency 

 Identifying torsional resonances in reciprocating machinery 

 Diagnosing the cause of gear “chatter” from torsional vibration. 

4.7.2 Input Signal Requirements 

The fixed sampling rate for the machine speed signal must be high enough to give a 

good definition of pulses. Note that the number of tachometer pulses/revolution 

determine the maximum torsional frequency of the analysis. In addition, the sampling 

rate must be at least 2.5 times the maximum frequency of interest to avoid aliasing 

effects. For example, for a maximum torsional frequency of 10 orders, you must have a 

tachometer capable of providing at least 2.5 x 10 pulses/revolution (25 

pulses/revolution). 

A good rule of thumb is to use 5–10 time over-sampling of the tachometer pulse 

frequency (not the machine speed) to get good, clean tachometer pulses. For example, 

for a tachometer that produces 25 pulses per revolution on a 60 RPM machine, sample 

the tachometer data at a rate of 125–250 samples/second. 

 

Since the torsional analysis algorithm works in the time domain, do not use aggressive 

anti-aliasing filters for the data acquisition. 

4.7.3 Example 

This example is from a 3-cylinder diesel engine. The data is from a non-contact sensor 

on a 72-teeth gear.  

1. The first plot is the time waveform, zoomed in to show more detail. To display a time 

waveform, select the tachometer signal in the signal list window and click the <Plot> 

button. 

25 pulses/rev 60 RPM
1 minute

60 seconds
-------------------------- 5 125 samples/second=



 Manual ibaRotate 

 

46 Issue 1.0 
 

 

 

Figure 39: Torsion Time Waveform 

2. Set the preferences to create the torsion file:  

 From the “Edit” menu choose “Preferences”.  

 Select “Create degrees per second torsion file” during tachometer processing so 

ibaRotate will create the torsion file.  

 ibaRotate also uses the sampling rate from this dialog window when processing 

the signal. This is not the same as the original sample rate used when collecting 

the data. A meaningful sample rate is 1/5 the rate of the tachometer signal. For 

example, for a 1000 Hz tachometer signal, use a sample rate of 200 Hz when 

processing the tachometer signal.  

3. Choose <OK> to close the Preferences dialog window. 

4. Process the tachometer signal. See “Processing a Tachometer Signal”. ibaRotate 

creates the torsion file at the same time, then displays the machine speed curve. 

Note this is the instantaneous speed in degrees/second. The machine speed curve 

shows the torsional speed changes as oscillations around the mean speed. 

 

Figure 40: Torsion Tachometer Analysis 
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Note 

After processing, choose “Preferences” from the “Edit” menu. Clear the check box for 

Create torsion file during tachometer processing unless you are going to create more 

torsion files immediately. Creating the torsion file during Tachometer processing can slow 

down ibaRotate. 

 

5. Close or minimize the machine speed plot. 

6. In the signal list window, select both the torsion file (*.tor) and the smoothed speed 

curve (use <ctrl> left-click to select multiple signals), then click the <Waterfall 

analysis> button to create a Waterfall plot (shown in Figure 41). The amplitude axis 

for the plot is in degrees/second. 

 

Figure 41: Torsion Waterfall 

 

Note that the torsional file includes a large DC component, equal to the mean machine 

rotational speed. The amplitude of the DC component is much greater than that of the 

higher order torsional vibration components, and must be excluded. 

7. Right click on the plot and select “Zoom”. Then click and draw a rectangle on the 

plot that excludes the DC component. See “Zoom in on the Time Waveform” in 

section 3.6. 

8. Right click on the plot and choose “Properties”. Select Viewed data only in the 

„Amplitude Axis“ tab of the dialog window to scale the amplitude axis to the zoomed 

part of the plot. Note that the torsion Waterfall plot shows the firing order at 1.5 

orders, and that in general, the torsional component driven by the firing orders is 

lower at higher speeds. The first order is the crankshaft imbalance, which increases 

with increasing speed. The other peaks are harmonics of the firing order. 

There is also a resonance as shown in Figure 42. 



 Manual ibaRotate 

 

48 Issue 1.0 
 

 

 

Figure 42: Torsion Waterfall Zoomed 

 

 

Note 

To change between frequency and order cursors, right click the plot and choose 

“Properties”. Then select the parameter for the cursor under “Track axis” on the “Cursor” 

tab. 

 

You can also use spline-fit machine speed curve produced by Tachometer analysis to 

display the torsional orders. 

1. Display the signal list window. 

2. Select the torsional file (*.tor) and the smoothed spline-fit file (*.spl) and click the 

<Computed Order Tracking> button. For this example, displaying the 1.0 and 1.5 

orders shows the firing order and the imbalance. The upper curve on the lower plot 

shows the firing order, and the lower curve shows the imbalance. Note the 

amplitude of the firing order curve decreases with increasing speed. 
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Figure 43: Torsion Comp Order Track 

3. Running the “Computed Order Tracking” again using more orders, and setting the 

X-axis to frequency shows all the peaks lining up at the resonant frequency. 

 

Figure 44: Order Tracking plot of orders 4, 4.5, 5, 4.5, and 6 

4.7.4 Theory 

Torsional vibration causes small variations in the speed of a rotating component. These 

variations can be detected in the speed signal from the component, if the signal provides 

sufficient resolution. ibaRotate processes the speed signal, and converts the variations 

in speed to the frequency domain. This generates a time history of the speed as a DC 

signal. If the original tachometer signal contains N pulses/rev, ibaRotate can extract 

torsional orders up to N/2 orders. 
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4.8 Order Normalization 

ibaRotate can resample a time waveform to order normalize the data when performing 

a Waterfall analysis. Order normalization cancels the effect of frequency smearing across 

spectral bins when the shaft speed is changing rapidly (high slew rate). Order 

normalization ensures that order-related peaks are properly aligned when plotted against 

the orders. 

Order normalization also enables you to use a smaller block size when performing the 

Waterfall analysis. This can significantly shorten processing time while maintaining good 

frequency and amplitude resolution. 

4.8.1 Applications 

Order normalization is ideal for identifying order-related frequencies in the Waterfall plot. 

Order-related frequencies are located at the running speed of the component and 

multiples of the running speed. The running speed is the first order. This is particularly 

useful when attempting to separate order-related and non-order-related peaks in the 

Waterfall plot. Since the X-axis is displayed in orders, it is easy to pick out the order-

related peaks. 

4.8.2 Input Signal Requirements 

Order normalization requires a smoothed speed curve from performing a Tachometer 

analysis or using the RPM from Waterfall function. ibaRotate processes the machine 

speed with the transducer data to create the order normalized Waterfall analysis. When 

collecting the non-tachometer data (vibration, pressure, etc.), note the following: 

 If you want to see low frequency data in the Waterfall analysis, make sure that the 

high pass filter setting in your analyzer is not excluding the desired low frequencies. 

 The sample rate in the analyzer must be at least 2.5 times the maximum frequency 

of interest to avoid aliasing. 

 The choice of window function for analysis depends on the type of resolution you 

need (amplitude or frequency resolution). The Hanning window is a good default 

choice, even though it can have substantial (1.6 dB worst case) amplitude error for 

fractional orders. The Flattop window gives a correct amplitude estimate, but with a 

severe loss of order resolution. The Uniform window is only a good choice when the 

orders are integer multiples of the shaft speed (1x, 2x, 3x, etc.), and will give the 

highest resolution of all windows. 

Order normalization requires a clean tachometer signal for best results. Processing the 

tachometer signal must produce a good spline-fit to provide a smooth speed curve. Note 

that the re-sampling algorithm does not require that the tachometer pulses correlate with 

the re-sampling angle. 

4.8.3 Example 

This example shows the difference in the appearance of a Waterfall plot resulting from 

order normalization. The first Waterfall plot (Figure 45) does not use order normalization. 
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Figure 45: Standard Waterfall 

 

The second Waterfall plot uses order normalization. Notice that the non-order-related 

peaks have been minimized, while order-related peaks have been enhanced (Figure 46). 

 

Figure 46: Order Normalized Waterfall 

 

1. To use order normalization when performing a Waterfall analysis, first select the 

smoothed machine speed and the data signals in the signals list window. Then click 

the <Waterfall analysis> button. 

2. In the Waterfall analysis dialog window, select „Order normalize“. Note that this is 

not available if you do not select the smoothed machine speed in the signals list 

window. 

3. Select the other desired parameters and choose <OK> to create the order 

normalized Waterfall plot. 
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4.8.4 Theory 

ibaRotate order normalizes the data by re-sampling it. Time waveform data is usually 

collected using a fixed number of samples/second. This means that more 

samples/revolution are collected at lower speeds, and fewer samples/revolution at higher 

speeds. Re-sampling enables ibaRotate to gather a constant number of samples per 

revolution, regardless of the speed of the machine. 

 

4.9 Millstrum Analysis 

Millstrum analysis in ibaRotate simplifies the process of identifying families of harmonics 

and sidebands. Harmonics are multiples of a primary frequency, and appear as a series 

of equally spaced spectral peaks of increasing frequency. Sidebands are pairs of equally 

spaced spectral peaks that appear to both sides of a primary frequency. Sidebands are 

often caused by modulation of the primary (“carrier”) frequency by a second frequency. 

In some cases, it can be difficult to identify harmonics and sidebands in a conventional 

Spectrum plot—particularly in spectra that have many peaks obscuring the harmonics or 

sidebands. 

Millstrum analysis simplifies the process of identifying harmonics and sidebands by 

removing everything that is not harmonic, and presenting the results in an easily-

understood format. Millstrum analysis is similar to using the cepstrum, but goes further 

in simplifying the results so that you do not have to perform any additional calculations. 

The fundamental frequency and modulating frequencies appear clearly as peaks in the 

Waterfall plot from Millstrum analysis. 

4.9.1 Applications 

Millstrum analysis is ideal for identifying harmonics and sidebands in the following 

applications: 

 Heavily modulated signals 

 Low amplitude harmonics and sidebands, such as in early-stage gearbox and 

bearing faults 

 Signals that produce complicated spectra with peaks obscuring the harmonics or 

sidebands. 

4.9.2 Input Signal Requirements 

You can use Millstrum analysis on a data signal without a smoothed machine speed 

curve; however, you will not be able to use the machine speed or order tracking 

capabilities of the Millstrum plot. 

ibaRotate processes the transducer data to create the Millstrum analysis. When 

collecting the non-tachometer data (vibration, pressure, etc.), note the following: 

 If you want to see low frequency data in the Millstrum analysis, make sure that the 

high pass filter setting in your analyzer is not excluding the desired low frequencies. 

 The sample rate in the analyzer must be at least 2.5 times the maximum frequency 

of interest to avoid aliasing. 

 When there is a tachometer signal, you can use the order domain for easier 

identification of the periodic frequencies. 
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 More spectral lines are required for the Millstrum analysis, since the analysis 

reduces the number of lines in the result by half. Collect a large number of sample 

points, and use the largest possible block size for the signal. This is explained in the 

section on “Theory” below. 

 The choice of window function for analysis depends on the type of resolution you 

need (amplitude or frequency resolution). If you are using order normalization, the 

Hanning window is a good choice. The Uniform window is only a good choice when 

the orders are integer multiples of the shaft speed (1x, 2x, 3x, etc.). 

4.9.3 Example 

This example is from an automotive dynamometer. The first Waterfall plot does not use 

Millstrum analysis. Notice the large number of peaks, and the difficulty in sorting out the 

harmonics. 

 

Figure 47: Pre-Millstrum Waterfall 

 

The second Waterfall plot is the result of the Millstrum analysis. Note that the peaks show 

the forcing and the harmonic frequencies. Remember that the X-axis, while in Hz, is not 

the same as the X-axis in the first Waterfall plot. Instead, you can read the forcing and 

harmonic frequencies directly from the X-axis. 
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Figure 48: Millstrum Waterfall 

 

To use Millstrum analysis, follow these steps: 

1. In the signal list window, select the time waveform signal (and a corresponding 

smoothed machine speed curve if desired). Then click the <Waterfall analysis> 

button. 

2. In the Waterfall analysis dialog window, select „Millstrum“ for the Window cor. 

parameter. 

3. Select the other desired parameters and choose <OK> to create the Millstrum plot. 

4.9.4 Theory 

A simple analogy is that Millstrum analysis looks at the spectrum as if it were a time 

waveform, and attempts to identify periodic repeating events in the spectrum. In other 

words, it takes the FFT of the FFT spectrum. Since both harmonics and sidebands are 

periodic repeating peaks in a spectrum, they show up in the Millstrum as single peaks. 

The “frequencies” of the peaks in the Millstrum are the frequencies of the repeating 

events. 

More formally, Millstrum analysis is essentially the Fourier transform of the logarithm of 

the absolute value of the frequency spectrum. It identifies periodicity in the frequency 

domain. The normal formulation, called the real cepstrum, has as its abscissa the period 

of the harmonics, but by inverting period, the Millstrum displays the results in the 

frequency domain. 

Millstrum analysis uses the logarithm of the frequency spectrum to raise the low 

amplitude peaks relative to higher amplitude components of the signal. This amplifies 

the presence of low amplitude harmonics, such as those created by early-stage bearing 

faults. 

For harmonics, the peaks in the spectrum are located at multiples of the primary 

frequency. The spacing (or “frequency”) between peaks is the same as the primary 

frequency. So harmonics in a spectrum appear as a single peak at the primary frequency 

in the Millstrum. 
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For sidebands, the peaks in the spectrum are located at the primary frequency plus or 

minus multiples of the modulating frequency. The spacing (“frequency”) between the 

peaks is the same as that of the modulating frequency. Sidebands appear as a single 

peak at the modulating frequency. 

 

4.10 Combinations of 2 Signals 

This option enables you to scale two time histories, then to add, multiply divide and 

subtract them. Example uses are for crankshaft twist and decoupling rotation from 

translation. 

 

4.11 Synchronous Averaging 

This feature re-samples to the angle domain, and produces a waterfall where the X-axis 

is two revolutions, i.e., 720 degrees, and the amplitude is the amplitude of the time 

history. If averaging is specified, the segments will all start at the same angular position, 

so that non period features will be averaged out, and only the systematic features remain. 

This enables the user to inspect the kinematics of a machine/engine as a function of 

shaft angle, and is very useful for identifying features in systems such as valve trains 

and fuel supply. Only the order components in the specified order range will be used, so 

that this also enables a zoom in the order domain. 

 

4.12 Preprocessing 

The Preprocessing function enables you to create a new time waveform by sampling 

existing time waveforms at a different rate. Also high and low pass filter can be assigned 

to the time waveform, linear trends can be removed, scales and offsets can be set and 

the spectrum type can be changed by integration or differentiation. 

 

4.13 Audio Playback of Time History Data 

ibaRotate can play an audio representation of the response in time history files through 

the sound card in your computer. To listen to a playback of your data, follow these steps: 

1. Select the signal of interest and plot it. 

2. With the plot on the screen, position the cursor before the area of interest. 

3. Press the icon with the <Play/Pause> button or choose “Play” from the “Analysis” 

menu. 

4. Press the icon during playback to pause. 
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5 ibaRotate Plotting Features 

This chapter describes the plots in ibaRotate. It covers the general features of plots that 

enable you to change the views of the data, as well as how to save a particular plot 

setting as the default for that type of plot. It then describes the individual plots that appear 

in ibaRotate. This chapter does not describe the applications for each plot. Refer to 

chapter 3 for the analyses that produce each type of plot. 

5.1 General Plot Features 

The plotting features described in this section are common to all of the plots, unless 

otherwise noted. 

5.1.1 Right-Click Menu 

To access the plot controls, right-click on the plot to display a menu of commands. 

 “Auto-Scale” - Set the plot axes to optimally display all the data on the plot. This is 

useful after you have used “Zoom” to examine a part of the plot in more detail. 

 “Zoom” - Magnify a region defined by clicking and dragging a rectangular region 

on the plot. The program enlarges the region to fill the plot window. 

 “Orientation” - Change the orientation of the plot axes by moving the mouse 

pointer then clicking to display the new plot orientation (Waterfall plot only). 

 “Add Cursor” - Select a cursor type to add to the plot in addition to the current 

cursors. The program displays the cursor properties dialog window, so that you can 

define the parameters for the cursor. 

 “Delete Cursor” - Delete the current cursor from the plot. 

 “Cursor Properties” - Display the “Cursor Properties” dialog window for the 

current cursor. 

 “Properties” - Display the plot properties dialog window. Click “Help” to display the 

online help explaining the fields in the dialog window. This dialog window controls 

the appearance of the plot, including the colors, labels, axis scaling, and numeric 

value display. 

5.1.2 Selecting the Active Trace 

If the plot contains multiple traces, you can select the active trace by clicking on the trace. 

The values displayed in the plot legend and the tooltips for the cursors are for the active 

trace. 

5.1.3 Selecting the Active Cursor 

Select the active cursor by clicking on the cursor. 

5.1.4 Moving a Cursor 

You can use either the mouse or the keyboard to move a cursor on a plot. 

 Use the mouse by clicking on a cursor and dragging it across the plot. You can also 

move a cursor to a different trace by clicking on the trace near the cursor. 

 Use the arrow keys to move the current cursor across the trace. You must still use 

the mouse to select a different cursor or plot trace. 

Normally the cursor moves from data point to data point along a trace. 



ibaRotate Manual  

 

 
Issue 1.0 57 

 

 If you hold down the <Ctrl> key when moving the cursor, the cursor jumps to the 

nearest peak in the trace (peak mode). 

 If you hold down the <Shift> key when moving the cursor, the cursor moves in 

increments of one-tenth of the distance between data points on the trace (fine 

mode). 

5.1.5 Saving the Plot Appearance as the Default 

The plot Properties dialog window enables you to change the appearance of the plot in 

many ways. You display the Properties dialog window by right-clicking on the plot and 

choosing “Properties”. Once you have changed the plot’s appearance to your 

satisfaction, you can save that appearance as the default for the plot type. Then when 

you open another plot of the same type, the new plot has the new default appearance. 

1. Use the plot „Properties“ dialog to change the plot appearance. 

2. From the “View” menu, choose “Save Plot Settings as Default”. 

 

5.2 Time Waveform Plot 

A Time Waveform plot is simply a plot of the amplitude of a signal against time in sec-

onds. You might use a Time Waveform plot for the following purposes: 

 To verify that a tachometer signal contains the correct signal. 

 To make sure that a signal has good data before proceeding with analysis. 

 To determine the time or duration of an event for further analysis. Some situations 

require recording hours of data to capture an event that might occupy only a few 

minutes of data. By slicing out only the relevant data, you can significantly shorten 

analysis time. 

1. Right-click a time waveform data signal in the signal list window and choose “Plot”. 

You can also do one of the following: 

 Select the signal and click the <Plot> button. 

 Double-click the signal. 

 Select a signal and choose the “Plot” command from the “Signals” menu. 

ibaRotate displays a plot of the time waveform.  

 You can overlay time waveforms by selecting two or more time waveform signals 

before plotting. Note that you cannot overlay other types of data on a Time 

Waveform plot. 

5.3 RPM (Machine Speed) Plots 

RPM profiles are time histories of instantaneous speed of a machine over time. You 

create these curves by performing a Tachometer analysis on a tachometer or other 

machine speed signal. ibaRotate can also create RPM curves without a tachometer from 

a Waterfall plot of a data signal. 

To display calculated RPM files, do one of the following: 

1. You can display a calculated raw RPM (*.raw file) curve or a smooth RPM (*.spl) 

curve by right-clicking the signal in the signal list window and choosing „Plot“. 

2. You can display both curves together by selecting both signals, then right-clicking 

one and choosing „Plot“. 
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5.4 Waterfall Plots 

The Waterfall plot displays multiple spectra as a function of time or spectra number or 

RPM. You create a Waterfall plot by performing a Waterfall analysis on data signal, or on 

the combination of a data signal and a machine speed signal. The Waterfall plot also 

shows an amplitude plot for the “slice” under the cursor. 

 

 

Figure 49: Waterfall with “Order cursor” positioned on the response ridge at order = 8.955 

ibaRotate will plot waterfalls in either the frequency domain or the order domain if the 

speed profile has been generated. ibaRotate will display cursors for either constant 

frequency or constant order. 

The key is to add the speed profile to the waterfall, which provides “order” information. 

This enables ibaRotate to plot the waterfall in either the frequency or order domain. Three 

ways to add the speed profile to the waterfall: 

 

1. Select both the data signal and the smooth RPM signal in the signal list window, 

and compute the waterfall analysis. 

2. If the waterfall has already been generated but without the speed profile, then 

select both the waterfall and the smooth RPM signals in the signal list window. Then 

right-click one and choose “Plot”. 

3. If you have already displayed a Waterfall plot, you can drag and drop the smooth 

RPM signal from the signal list window onto the Waterfall plot. ibaRotate recalcu-

lates the waterfall using the smoothed speed curve. 
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5.5 Contour Plots 

The Contour plot is another way to view a waterfall. The Contour plot uses contour lines 

or colors to identify areas of equal amplitude. While the view in a Waterfall plot is “across” 

the spectra from the side, the view in a Contour plot is from “above” the spectra, looking 

down on the data. 

 

Figure 50: Contour Plot as function of time with “order cursor” at order = 8.995 

 

Three ways to display a Contour plot: 

1. Display a Waterfall plot and then from the “View” menu choose “Toggle Waterfall 

Type”. 

2. Right click in the Waterfall plot and select “Toggle Waterfall Type”. 

3. From the “Edit” menu choose “Preferences”. Set Default Waterfall plot type to 

Contour. Then if you perform a Waterfall analysis or display a waterfall file, 

ibaRotate shows a Contour plot by default. 

Waterfall plots with speed data may also be plotted vs. RPM, as shown in Figure 51. 
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Figure 51: Contour Plot as function of RPM with “order cursor” at order 9 

 

5.6 Order Tracking Plots 

The Order Tracking plot displays the result of the Computed Order Tracking analysis in 

a Bode plot format. The lower plot shows the magnitude plotted against frequency, time, 

or machine speed for each order. The upper plot shows the phase plotted against the 

frequency, time, or machine speed for each order. 

 

Figure 52: Order Tracking Plot 

 

To display calculated Order traces, do one of the following: 
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1. You can display a calculated Orders (orders*.tra file) curve by right-clicking the 

signal in the signal list window an choosing “Plot”. 

2. You can display multiple order curves together (as shown above) by selecting the 

signals in the signal list window, then right-clicking one and choosing “Plot”. 
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6 Command Reference 

Commands available in ibaRotate are listed in alphabetical order below, with notes 

describing options. 

6.1 AC Coupling 

Found in the preferences dialog window. New functions that are generated will be high 

pass filtered to remove the DC component. The numeric value is the filter cutoff in Hz. 

6.2 Add Button 

Adds the value in the Order Drop-Down box to the Orders List. Analysis will create a plot 

for each order number in the list. 

6.3 Add Cursor Options 

Specialized cursors can be added and deleted to any plot in ibaRotate. In ibaRotate, 

there are seven different cursor types that may be added onto the plot. When cursors 

are placed on waterfall or contour plots, their values as individual lines on the amplitude 

plots found in the upper pane of the respective plots.  

Cursor Type: 

 Single: Standard single cursor 

 Harmonic: Multiple cursors evenly spaced 

 Sideband: A central cursor with evenly spaced sidebands 

 Rolling Element Bearing: Consists of six cursors 

 Gearbox: Consists of eight cursors 

 Planetary Gearbox: Consists of eleven cursors 

 

To remove the active cursor, right-click the plot and select Delete Cursor. 

See also: 

 Chapter 6.50 Single Cursor Properties 

 Chapter 6.24 Harmonic Cursor Properties 

 Chapter 6.49 Sideband Cursor Properties 

 Chapter 6.44 Rolling Element Bearing Cursor Properties 

 Chapter 6.23 Gearbox Cursor Properties 

 Chapter 6.36 Planetary Gearbox Cursor Properties 
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6.4 Add File 

Files can be added to the signal list in four ways:  

 From the “File” menu, choose “Add File”  

 From the “Signals” menu, choose “Add File”  

 Click the <Add File> button in the toolbar  

 Right-click in the signal list window and select “Add Files…” 

 

 

Figure 53: Add Files dialog 

 

All users has the option to add these file types : 

 iba dat Files (.DAT) 

 Vold Trace Files (.TRA) - Generated by the Computed Order Tracking Module  

 Vold Waterfall Files (.WAT) - Generated by the Waterfall Generation Module  

 Vold Spline Files (.SPL) - Generated by the Tachometer Processing Module  

 Vold Raw RPM Files (.RAW) - Generated by the Tachometer Processing Module 

The user who has purchased the ibaRotate-Add-on non-iba files license can also add 

the following types : 

 ASCII Files (.ASC) - ASCII Data Files 

 CSV Files (.CSV) – comma separated values text file (comma, space, or tab 

delimited) 

 DSPCon Files (.datx_index) – DSPCon Data Files 

 Matlab Files (.MAT) - Matlab Data Files 

 Medallion Files (.MRD) - Medallion Data Files 

 Megadac Files (.0??) - Megadac Data Files 

 SDF Files (.SDF) - HP Data Files 
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 Universal #58 Binary Files (.BUNV) - Universal Data Files 

 Universal #58 Text Files (.UNV) - Universal Data Files 

 Somat Ease Files (.SIF) - Somat Ease Data Files 

 Sony PCscan MKII Files (.LOG) - Sony PCscan MKII Data Files 

 Teac QuikVu Files (.DAT) - Teac QuikVu Data Files 

  Wave Files (.WAV) – Waveform data file 

 

6.5 Amplitude Plot 

Amplitude plots can be found above Waterfall and Contour plots.  

 See chapter 6.40 for further details. 

6.6 Automatic Plotting after Analysis 

When this option is checked, the plot will be automatically displayed after an analysis is 

performed. If you choose not to check this option no plot will be shown after the analysis, 

but the results are still automatically placed in the signals list. You can plot the data from 

there at a later time. 

 See also chapter 6.38 

6.7 Auto-Scale 

Choosing Auto-Scale will redraw the selected Waterfall plot to the original non-zoomed 

state as it was originally plotted. 

6.8 Average Type 

The user may choose between three types of averages:  

Stable  This is the mean of the spectra 

Peak Hold   In this method, the extreme peaks are kept from each spectrum 

Exponential This is an averaging method using the scheme:  

    Xn = ( - 1/ ) Xn - 1+Xn /

6.9 Averages 

The user may want to obtain spectra which are the average of more than one block. This 

will contribute to usage of more data and tend to average out noise effects. The blocks 

may or may not overlap. It is reasonable to use some overlap, say, 30%, so that some 

data gets reused in each subsequent block. This will tend to compensate for filter effects 

that tend to undervalue data near the block ends. A reasonable number of averages is 

three; more than five are rarely used. It is typical to use averaging during reasonably 

slow speed changes.  

 

 

Note 

If only one average is used (Averages = 1), no averaging will be performed. 
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6.10 Blocksize 

The Blocksize is the number of samples contained in a timeblock of length T for which 

each spectrum will be computed before averaging. It is normally a power of 2, such as 

256, 512, 1024, 2048...,etc. However, the user has the choice of choosing a “convenient” 

number slightly below the exact ½ Blocksize. For example, Spectral Lines = 400 instead 

of 512. 

The sampling rate is the number of time samples/second, or the inverse of the time 

increment Δt. 

6.11 Bode Plot  

Magnitude and Phase values created by the computed order tracking analysis. 

6.12 Compute Complex Orders (Orders with Phase) 

When this option is selected, complex orders are computed. These complex orders 

include phase information relative to the tachometer signal. 

6.13 Contour Displays 

Contour displays are another method of presenting Waterfall data. ibaRotate lets you 

change from Waterfall plots to Contour plots easily by selecting “Toggle Waterfall Type” 

from the “View” menu.   

 

Figure 54: Contour Plot 

 

 See also chapter 6.14  
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6.14 Contour Plot Properties 

Selecting the “Properties” option on a Contour plot will bring up the Properties dialog 

window containing multiple option tabs. 

The tabs include: 

 General 

 Cursor 

 Amplitude Axis 

 Z Axis 

 X Axis 

 Numeric 

 Scheme 

 

6.14.1 General 

 

 

Figure 55: General tab 

 Style: 

Intensity: This uses a rectangular region for each amplitude to set a color intensity 

Contour/Contour Fill: Contour and contour fill use a polygon method to create smooth 

contour transitions 

 Color: 

Resolution colors specifies the number of color bins to use in creating the contour plot. 

Displaying the color bar will show the data value range and the color associated with 

those values. 

 Title:  

Places an additional title text above the plot along with the signal name. 
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6.14.2  Cursor 

 

Figure 56: Cursor tab 

The “Cursor” tab enables you to select which axis the cursor will track along and which 

units to use while tracking.  

 Track Axis: 

Changes which axis the cursor tracks along. The drop-down menu can be used to 

change which units the cursor will use. 

 Current Value: 

Positions the cursor at a specific place along the currently selected axis. 

6.14.3  Amplitude Axis 

 

Figure 57: Amplitude Axis tab 

The “Amplitude Axis” tab enables the user to set the scale and limits for the Amplitude 

Axis on the current Waterfall plot as well as adjusting display of the Amplitude Axis. 

 Scale: 

Linear: Sets the scale to Linear based values. 

Log10: Sets the scale to Log10 based values. 

dB: Sets the scale to dB based values. 
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 Units:  

Not applicable for contour plots. 

 Limits:  

Auto-scale: Uses absolute minimum and maximum values configured for the Waterfall. 

Auto-scale Optimized: Uses the rounded off minimum and maximum values as limits. 

Fixed: Enables the user to specify the left and right limits. 

 Viewed Data Only:  

When viewed data only is selected, only the data that is being viewed will be auto-scaled, 

rather than the whole data set. 

 Grids:  

Major/Minor Grids: Enables/Disables display of gridlines for major and minor tics along 

the amplitude axis. 

Major/Minor Tics: Enables/Disables display of the major and minor tic marks along the 

amplitude axis. 

Major/Minor Division: Sets the interval between the major and minor tic marks along 

the amplitude axis. These values are set automatically by ibaRotate when this option is 

not selected. 

6.14.4  Z Axis 

 

Figure 58: Z Axis tab 

The “Z Axis” (RPM Axis) tab enables the user to set the units, scale and limits of the RPM 

Axis on the current Waterfall plot as well as adjusting display of the Z-axis. 

 Units: 

Enables the user to choose the Z-axis units when there is more than one option 

(seconds, Hz, RPM, etc.). 

 Scale: 

Not applicable to contour plots. 

 Limits: 

Auto-scale: Uses absolute minimum and maximum values configured for the Waterfall. 

Auto-scale Optimized: Uses the rounded off minimum and maximum values as limits. 

Fixed: Enables the user to specify the left and right limits. 
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 Grids:  

Major/Minor Grids: Enables/Disables display of gridlines for the major and minor tics 

along the Z-axis. 

Major/Minor Tics: Enables/Disables display of the major and minor tic marks along the 

Z-axis. 

Major/Minor Division: Sets the interval between the major and minor tic marks along 

the Z-axis. These values are set automatically by ibaRotate when this option is not 

selected. 

6.14.5 X Axis 

 

Figure 59: X Axis tab 

The “X Axis” (Frequency Axis) tab enables the user to set the units, scale, and limits of 

the Frequency Axis on the current Waterfall plot as well as adjusting display of the X-

axis. 

 Units: 

Enables the user to choose the X-axis units when there is more than one option 

(seconds, Hz, RPM, etc...etc.). 

 Scale: 

Linear: Sets the scale to Linear based values. 

Log10: Sets the scale to Log10 based values. 

dB: Sets the scale to dB based values. 

 Limits: 

Auto-scale: Uses absolute minimum and maximum values configured for the Waterfall. 

Auto-scale Optimized: Uses the rounded off minimum and maximum values as limits. 

Fixed: Enables the user to specify the left and right limits. 

 Grids:  

Major/Minor Grids: Enables/Disables display of gridlines for the major and minor tics 

along the X-axis. 

Major/Minor Tics: Enables/Disables display of the major and minor tic marks along the 

X-axis. 

Major/Minor Division: Sets the interval between the major and minor tic marks along 

the X-axis. These values are set automatically by ibaRotate when this option is not 

selected.  
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6.14.6  Numeric 

 

Figure 60: Numeric tab 

The “Numeric” tab adjusts the display of numbers along a specific axis for the current 

Waterfall plot. 

 Numeric Format Properties For: 

Sets the axis to be formatted. 

 Type: 

Fixed: Sets the scale to a fixed number of decimal places based on the precision value. 

Metric: Sets the scale to metric numbers based on the significant digits value. 

Scientific: Sets the scale to scientific numbers based on the exponent width and 

significant digits values. 

Engineering: Sets the scale to engineering numbers based on the exponent width and 

significant digits values. 

 Significant Digits: 

Changes the number of significant digits displayed in the values along the selected axis. 

 Precision: 

Changes the precision of the numbers along the selected axis for Fixed type values.  

 Exponent Width: 

Changes the number of digits used to represent the exponent value for Scientific and 

Engineering type values.  
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6.14.7 Scheme 

 

Figure 61: Scheme tab 

The “Scheme” tab enables you to change the colors and display properties of the 

different elements in the plot. 

 Scheme: 

Black and White: Sets all of the colors in the plot to black and white.  

Color Printer: Enables the user to specify the colors he wants each element in the plot 

to be. 

Default: Sets the plot to the default colors: green data on a black background. 

Silver Theme: Gray and white colors. 

 Save As: 

Enables the user to save a color scheme to select later or for use in other Waterfall plot 

windows. 

 Color Map: 

Changes the color map definition for the data range. The color map property can be used 

to effectively view depth on a contour plot. 

 Element: 

Select an element from the drop-down menu. Any display properties (color, font, etc.) 

associated with it will be available for modification in the options below. Data1 is the color 

of the data in the Waterfall plot. 

 See also: How to Add/Delete Cursors and Cursor Options 

 

6.15 Copy to Clipboard 

The “Copy to Clipboard” feature in ibaRotate enables you to take data from any plot 

created in ibaRotate, copy it to the clipboard, and paste it into MS Excel, Word, or other 

applications that handle image or text data. This feature makes ibaRotate a useful tool 

in creating reports, presentations, or doing further data manipulation. 

Select and plot any signal in the signals list to begin. Once you have plotted the signal, 

making sure it is still selected, click the <Copy> to Clipboard button found on the toolbar. 

You will not notice anything happen on the screen, but ibaRotate has copied the 

information contained in the plot and placed it on your computer’s clipboard.  
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To paste the data you have copied into your application, you can do a <Ctrl> + <v> or go 

to the “Edit“ menu and select either “Paste” or “Paste Special”. In certain Office 

applications, the “Paste Special” will open a dialog window with multiple choices 

including: picture, bitmap, and text. When you select picture, you will paste a Windows 

Metafile (.wmf) onto the page. This option is useful because the picture will reformat to 

each size you choose without distorting. The plot will remain just as when you saw it in 

ibaRotate. Choosing the bitmap option will also paste a picture on the sheet, but it will 

paste a bitmap. The difference between a bitmap and a metafile is when sizing a bitmap, 

the picture can become distorted, but with the metafile it remains clear. Lastly, to see the 

actual data from the plot, choose text. This will print the data in column form. The 

following is an example of an Excel spreadsheet after choosing picture and text from the 

Paste Special dialog window. (Note: To paste both a picture and text on the sheet, you 

will have to do two separate Paste Special commands.) 

 

Figure 62: Data pasted in Excel 

 

6.16 Create Torsion File during Tachometer Analysis 

When this option is checked, a torsional analysis will be performed during a tachometer 

analysis and a file with a .tor extension will be placed in the Signal List.  

6.17 Cursor Control 

Selecting the active cursor 

Select the active cursor by clicking on the cursor. 

Moving a cursor 

You can use either the mouse or the keyboard to move the active cursor on a plot. 



ibaRotate Manual  

 

 
Issue 1.0 73 

 

 You can use the mouse by clicking on a cursor and dragging it across the plot. You 

can also move a cursor to a different trace by clicking on the trace. 

 You can use the arrow keys to move the current cursor across the trace. You must 

still use the mouse to select a different cursor or trace. 

Normally the cursor moves from data point to data point along a trace. 

 If you hold down the <Ctrl> key when moving the cursor, the cursor jumps to the 

nearest peak in the trace (peak mode). 

 If you hold down the <Shift> key when moving the cursor with the arrow keys, the 

cursor moves in increments of one-tenth of the distance between data points on the 

trace (fine mode). If you hold down the <Shift> key when moving the cursor with the 

mouse, the cursor goes to the position of the mouse pointer. 

Selecting the active trace 

If the plot contains multiple traces, select the active trace by clicking on the trace. The 

values displayed in the tooltips for the cursors are for the active trace. 

6.18 Default Time Increment 

This parameter is found in the ibaRotate preferences dialog. In some types of data files, 

the time increment of the data (the time between data points) is not specified. For those 

types of files, this parameter specifies what time increment should be used to make 

calculations on the data. Enter values in terms of seconds. 

6.19 Default Waterfall Plot Type 

This specifies whether the data will be plotted in a color contour or waterfall fashion. This 

is used for Waterfall Generation data. If you choose the Color Contour option, the results 

of your waterfall generation will be displayed as a color contour. 

6.20 Delete Button 

Removes an order from the Orders List. 

6.21 Display Total Energy in Waterfall Plots 

When this option is checked, the total energy of the signal will be displayed along with 

the cursor slice above Waterfall plots. 

6.22 Exponential Time Constant 

For the n-th block, an average Xn is calculated, where the user-supplied parameter 

the Exponential Time Constantis used to control the averaging. The larger the value of, 

the more the averaging “remembers the past”. Note that as approaches infinity, “Stable” 

averaging occurs. For  = 1, there is no averaging. Hence,  should be greater than one. 

6.23 Gearbox Cursor Properties  

Use this dialog window to view and change the properties for gearbox cursors on the 

plot. The gearbox cursor consists of 8 individual cursors: 

Input: Input shaft speed 

Output: Output shaft speed 

Mesh: Gear mesh frequency 
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2xMesh: 2 times the gear mesh frequency 

3xMesh: 3 times the gear mesh frequency input shaft speed input shaft 

speed 

Mesh-Input: Gear mesh minus input shaft speed 

Mesh+Input: Gear mesh plus input shaft speed 

Mesh-Output: Gear mesh minus output shaft speed 

Mesh+Output: Gear mesh plus output shaft speed 

Assembly 

Phase: 

Frequency at which an assembly passes through the mesh 

Hunting 

Tooth: 

Frequency at which a specific tooth on one gear contacts a specific 

tooth on the other gear 

Name: Enter the name for the cursor. The name appears in the tooltip for 

the cursor. 

Input gear 

teeth: 

Enter the number of gear teeth on the input gear 

Output gear 

teeth 

Enter the number of gear teeth on the output gear 

 

Note that for some combinations of gear teeth, two or more cursors will be at the same 

frequency. In that case, the plot only displays one cursor at that frequency. 

6.24 Harmonic Cursor Properties  

Use this dialog window to view and change the properties for harmonic cursors on the 

plot. A harmonic cursor consists of the primary cursor and secondary cursors spaced at 

integer multiples (orders or harmonics) of the X-axis value for the primary cursor. In other 

words, if the primary cursor is at 2, the first three secondary cursors appear at 4, 6, and 8. 

 Name:  

Enter the name for the cursor. The name appears in the tooltip for the cursor. 

 Size:  

Enter the number of harmonic cursors you want to display. 

 Display values for all harmonics:  

Display the Z-axis values at each harmonic cursor in the plot legend. Otherwise, the 

program displays only the amplitude value at the primary cursor. 

6.25 Hold Off 

Hold off is the time (in seconds) after a trigger during which another trigger cannot occur. 

This is specified because when a trigger occurs, there is usually noise in the signal at 

that point. The hold off parameter gives that noise a chance to settle down after a 

triggering event so that no false triggers occur due to it. 

6.26 Hysteresis 

Hysteresis is an uncertainty tolerance to enable for low level noise in the tachometer 

signal. It in effect widens the trigger level so that noise in the signal will not cause a false 

trigger to occur. Try choosing it close to the perceived level of the noise or a little larger. 
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6.27 Increment  

Used when specifying Time or RPM as the Tracking Method. ibaRotate expects an 

increment value of Time or RPM. The user should be aware of the total time or RPM 

ranges to select a reasonable value. 

6.28 Integration/Differentiation 

The spectrum can be integrated or differentiated once or twice. For example, if the 

velocity spectrum is sought but the original signal is acceleration, single integration may 

be applied. If a displacement spectrum is desired, apply double integration. 

Conversely, displacements may be converted to velocities by differentiating once and to 

accelerations by differentiating twice. Velocities may be converted to accelerations by 

differentiating once.  

Single differentiation implies multiplying the spectrum by j*, where  is the circular 

frequency. Double differentiation implies multiplying the spectrum by **2. Integration 

implies dividing by these quantities. 

6.29 Maximum Number of Spectra 

Here, the user specifies the required number of spectra if “None” is chosen in the 

Tracking Method window. ibaRotate will figure out the required intervals. This window is 

also used as a “safety ceiling” (maximum number of spectra) if RPM or Time Tracking is 

used.  

6.29.1 Maximum Number of Values 

This specifies the number of values compiled per order function. For RPM or Time 

Tracking this is used as a “safety ceiling” in case an inappropriate increment is selected. 

6.30 Maximum  

Specifies the maximum value in RPM or Seconds. The check window to the left must be 

checked for this value to be used.  

6.31 Minimum  

Specifies the minimum value in RPM or Seconds. The check box to the left must be 

checked for this value to be used.  

6.32 Number Of Spline Segments 

If spline interpolation is chosen, the user can specify the number of spline segments. The 

fewer the segments, the “stiffer” the interpolation, but the less “precise” the estimate 

approximation. 

It is recommended that the user views the results of the RPM estimate and compare the 

raw versus the interpolated estimate before proceeding. 

6.33 Order 

Specifies one order to be added to the Orders List. 

6.34 Orientation 

This enables you to rotate the orientation, visual point of view, of the 3-D spectral display. 

Once selected from the pop-up menu, move the mouse to change the orientation and 

click to accept. 



 Manual ibaRotate 

 

76 Issue 1.0 
 

 

6.35 Overlap Percentage 

This value represents the percentage overlap, or reuse of data, between time blocks. 

6.36 Planetary Gearbox Cursor Properties  

Use this dialog window to view and change the properties for planetary gearbox cursors 

on the plot. The gearbox cursor consists of 11 individual cursors: 

Sun: sun gear frequency 

Carrier: carrier frequency 

Ring: ring gear frequency 

Mesh: gear mesh frequency 

Sun defect:  sun gear defect frequency 

Ring defect:  ring gear defect frequency 

Planet defect:  planet gear defect frequency 

Inner AP: frequency at which an assembly passes through the inner mesh 

Inner HT: frequency at which a specific tooth on a planet gear contacts a 

specific tooth on the sun gear (hunting tooth frequency) 

Outer AP: frequency at which an assembly passes through the outer mesh 

Outer HT: frequency at which a specific tooth on a planet gear contacts a 

specific tooth on the ring gear (hunting tooth frequency) 

Name: Enter the name for the cursor. The name appears in the tooltip for 

the cursor 

Fixed ring: Gearbox is mounted such that the ring gear or annulus does not 

rotate 

Fixed carrier:  Gearbox uses a fixed carrier 

Fixed sun: Gearbox uses a fixed sun gear 

Sun teeth: Number of teeth on the sun gear 

Planet teeth:  Number of teeth on the planet gears 

Ring teeth:  Number of teeth on the ring gear 

Planet count:  Number of planet gears 

 

Note that for some combinations of gear teeth, two or more cursors will be at the same 

frequency. In that case, the plot only displays one cursor at that frequency. 

6.37 Plot 

Files can be plotted from the Signal List in four ways.  

 Select (left-click) the signal and click the “Plot” button on the toolbar. 

 Double-click the signal in the signal list. 

 Select the signal and choose “Plot” from the “Signals” menu. 

 Right-click the signal and select “Plot” from the pop-up menu. 

If multiple amplitude signals are selected, they will be plotted on the same graph. 
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6.38 Preferences 

This dialog window enables you to change overall preferences for ibaRotate. To access 

it, choose “Preferences” from the “Edit” menu. For a detailed description of the options 

available, choose from the following: 

 

Figure 63: Preferences dialog 

 Frequency Units:  

Sets either Hertz and Cycles per Minute as the default frequency unit. 

 Default Waterfall Plot Type:  

Sets either Contour and Waterfall as the default Waterfall plot type. 

 Project Name:   

Name for automatically stored plot configuration files, which are automatically retrieved 

for consistent plot default appearance in later ibaRotate sessions. 

 Default Sampling Frequency:  

Sets the default sampling frequency. 

 Equivalent Time Increment:  

The time increment for sampling (inverse of sampling frequency). 

 AC Coupling:  

Enabling this option filters new functions so DC component is removed.  

 Automatic Plotting after Analysis:  

Enabled by default, this option creates an automatic plot of data after analysis is 

complete. 



 Manual ibaRotate 

 

78 Issue 1.0 
 

 

 Short UFF Signal Names:  

Shortens UFF signal names to keep filenames succinct. 

 Create Degrees Torsion File During Tachometer Processing:   

Creates an angular position .tor file in the signal list whenever tachometer processing is 

done. 

 Create Degrees Per Second Torsion File During Tachometer Processing:  

Creates an angular velocity .tor file in the signal list whenever tachometer processing is 

done. 

 Enable Glitch Filter on Counter Signals:  

Handles glitches in counter signals with a heuristic filter. 

 Results Directory:  

Sets the default directory results are saved in. 

 

6.39 Print Preview 

Print preview enables the user to view how the selected plot will appear when printed. 

This can be activated either by clicking the <Print Preview> button on the toolbar or by 

selecting “Print Preview” from the “File” menu. The following is an illustration of this 

capability: 

 

Figure 64: Print preview 
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6.40 Properties…  for 2D Amplitude Plot 

Right-click on a plot to show the context menu for that plot. Note that the top “splitter 

window” and the bottom main window may have different properties. Select 

“Properties…” to bring up the “AmpPlot Properties” dialog box for that plot. The 

Properties dialog box has six tabs which are each described below. 

 

 

Figure 65: 2D Amplitude Plot 

 

6.40.1 General 

 

Figure 66: General tab 

The “General” tab has the following options: 
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 Title:  

adds a title above the plot (to the left of the signal name if only one signal is plotted). 

 Vertical Labels:  

makes the ordinate label vertical or horizontal. 

 Display Legend:  

displays line segments and signal names in the cursor box if more than one line on plot. 

(If only one line on plot, the signal name is printed as a title.) 

6.40.2 Cursor 

 

Figure 67: Cursor tab 

The “Cursor” tab enables the user to choose what type and style of cursor to use. 

 Current Value:   

Gives the position of the cursor in X-axis units. This field can be used to move the cursor 

to an exact position along the X-axis. 

 Style:  

Vertical Line: Uses a straight, vertical line to trace the data. 

Lines: Traces the data using a vertical and horizontal line. 

Cross: Sets a cross to trace the data. 

Box: Sets a box to trace the data. 
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6.40.3 Amplitude Axis 

 

Figure 68: Ampitude Axis 

The “Amplitude Axis” tab enables the user to choose the scale and limits on the Y-axis. 

 Scale:  

Linear: Sets the scale to Linear based values. 

Log10: Sets the scale to Log10 based values. 

dB:  Sets the scale to dB based values. 

 Units:   

Enables the user to choose the X-axis units when there is more than one (seconds, Hz, 

RPM, etc...). 

 Limits:  

Auto-scale: Uses absolute minimum and maximum values configured for the Waterfall. 

Auto-scale Optimized: Uses the rounded off minimum and maximum values as limits. 

Fixed:  Enables the user to specify the left and right limits. 

 Viewed Data Only:   

When viewed data only is selected, only the data that is being viewed will be auto-scaled, 

rather than the whole data set. 
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6.40.4  X Axis 

 

Figure 69: X Axis tab 

The “X Axis” (Frequency Axis) tab enables the user to set the units, scale and limits of 

the Frequency Axis on the current Waterfall plot as well as adjusting display of the X-

axis. 

 Scale:  

Linear: Sets the scale to Linear based values. 

Log10: Sets the scale to Log10 based values. 

dB:  Sets the scale to dB based values. 

 Units:  

Enables the user to choose the X-axis units when there is more than one option 

(seconds, Hz, RPM, etc...etc.). 

 Limits:  

Auto-scale:Uses absolute minimum and maximum values configured for the Waterfall. 

Auto-scale Optimized:Uses the rounded off minimum and maximum values as limits. 

Fixed: Enables the user to specify the left and right limits. 

 Grids:  

Major/Minor Grids: Enables/Disables display of gridlines for the major and minor tics 

along the X-axis. 

Major/Minor Tics: Enables/Disables display of the major and minor tic marks along the 

X-axis. 

Major/Minor Division: Sets the interval between the major and minor tic marks along 

the X-axis. These values are set automatically by ibaRotate when this option is not 

selected. 
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6.40.5 Numerics 

 

Figure 70: Numeric tab 

The “Numeric” tab adjusts the display of numbers along a specific axis for the current 

Waterfall plot. 

 Numeric format properties for: 

Sets the axis to be formatted. 

 Type: 

Fixed: Sets the scale to a fixed number of decimal places based on the precision value. 

Metric: Sets the scale to metric numbers based on the significant digits value. 

Scientific: Sets the scale to scientific numbers based on the exponent width and 

significant digits values. 

Engineering: Sets the scale to engineering numbers based on the exponent width and 

significant digits values. 

 Significant Digits:  

Changes the number of significant digits displayed in the values along the selected axis. 

 Precision:  

Changes the precision of the numbers along the selected axis for Fixed type values.  

 Exponent Width:  

Changes the number of digits used to represent the exponent value for Scientific and 

Engineering type values. 
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6.40.6 Scheme 

 

Figure 71: Scheme tab 

The “Scheme” tab enables you to change the colors and display properties of the 

different elements in the plot. 

 Scheme: 

Black and White: Sets all of the colors in the plot to black and white.  

Color Printer: Enables the user to specify the colors he wants each element in the plot 

to be. 

Default: Sets the plot to the default colors: green data on a black background. 

Silver Theme: Gray and white colors. 

 Save As: 

Enables the user to save a color scheme to select later or for use in other Waterfall Plot 

windows. 

 Color Map: 

Does not affect 2D plot. 

 Element: 

Select an element from the drop-down menu. Any display properties (color, font, etc.) 

associated with it will be available for modification in the options below. Data1 is the color 

of the data in the Waterfall plot. 

 

 

Note 

The Line Style and Marker options only change the display of data in the upper pane of 

the Waterfall Plot window. 
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6.41 Remove a File or Signal from the Signal List 

Removing entries from the signal list window does not delete any data, and you can add 

the data files back at any time. Three ways to remove a file from the signal list: 

1. Left-click the demo data file to highlight in the signal list, then select the “Signals” 

menu and “Remove” command. 

2. Left-click the demo data file to highlight, and press the „Delete“ key. 

3. Right-click the demo data file in the signal list, and select “Remove” 

 

 

Note 

Note that these methods remove all selected entries, not just the one you right-clicked. 

You can select more than one entry in the list by holding down the <Ctrl> key and clicking 

additional entries. If you hold down the <Shift> key, you can select a range of entries. 

 

 

Figure 72: Remove a signal 

6.42 Rename a Signal 

ibaRotate generates one or more signals each time you perform any type of analysis. 

ibaRotate automatically names a generated signal by combining the signal name and 

the data file name. Renaming a generated signal can help you remember the purpose 

or parameters of that analysis. 

Note that you can only rename generated signals. You cannot rename signals from an 

original data file. 

1. Right-click a signal and choose “Rename”. 
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Figure 73: Rename a signal 

 

2. Enter the new name for the signal and press <Enter>. 

 

 

Note 

You can also select a signal and choose the “Rename” command from the “Signals” 

menu. 

 

6.43 Results Directory 

This specifies the default directory in which results will be saved.  

6.44 Rolling Element Bearing Cursor Properties 

Use this dialog window to view and change the properties for bearing cursors on the plot. 

The bearing cursor consists of six individual cursors. 

Speed: FTF: Fundamental train frequency 

BSF: Ball spin frequency 

2xBSF: two times ball spin frequency 

BPIR: Ball pass inner race frequency 

BPOR: Ball pass outer race frequency 

Name: Enter the name for the cursor. The name appears in the tooltip 

for the cursor. 

Geometry:  Define the bearing by entering the physical parameters for the 

bearing. 

Estimator:  Enter only the number of rolling elements. The program 

estimates the frequencies based on the number of elements. 

Orders:  Enter the frequency parameters for the bearing in orders of 

running speed 
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Rolling element 

count:  

Enter the number of rolling elements 

Rolling element 

diameter:  

Enter the rolling element diameter 

Pitch diameter:  Enter the element pitch diameter 

Contact angle:  Enter the contact angle between the balls and the races 

BSF:  Enter the ball spin frequency in orders of running speed 

FTF:  Enter the fundamental train frequency in orders 

BPIR:  Enter the ball pass inner race frequency in orders 

BPOR:  Enter the ball pass outer race frequency in orders 

 

6.45 RPM at 0 Unit 

This parameter is used to specify which RPM corresponds to a tachometer input at zero. 

6.46 RPM/unit 

This parameter is used to scale the input tachometer signal to the corresponding RPM. 

This must be used in conjunction with the “RPM at 0 unit” value. 

6.47 Sampling Frequency 

This parameter is in the inverse of the Default Time Increment. It is possible to enter the 

sampling frequency instead of a Default Time Increment if it is more convenient. 

6.48 Shave Percentage 

The Shave Percentage specifies the amount of Raw RPM Estimates that are removed 

from the data set after an initial Spline Estimate is performed. The Raw RPM Estimates 

are ranked according to how much they deviate from the initial Spline Estimate. Once 

the Raw RPM estimates are removed a new spline fit is performed. The Shave 

Percentage parameter is especially useful when the tachometer signal is noisy or suffers 

from signal “dropout”. 

6.49 Sideband Cursor Properties  

Use this dialog window to view and change the properties for sideband cursors on the 

plot. A sideband cursor consists of the primary cursor and pairs of secondary cursors 

spaced at a constant X-axis distance from the primary cursor. In other words, if the 

primary cursor is at 3 and the sideband spacing is 1, the first three pairs of secondary 

cursors appear at 2 and 4, 1 and 5, 0 and 6. 

 Name:  

Enter the name for the cursor. The name appears in the tooltip for the cursor.  

 Number of sidebands:  

Enter the number of sideband cursor pairs. 

 Display readout for sidebands:  

Display the X-axis value at each harmonic cursor in the plot legend. Otherwise, the 

program displays only the X-axis value at the primary cursor and the sideband spacing 

(delta). 
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6.50 Single Cursor Properties 

Use this dialog window to view and change the properties for a single cursor on the plot. 

 Name:  

Enter the name for the cursor. The name appears in the tooltip for the cursor. 

6.51 Slope 

 Positive:  

“Slope” option “Positive” means a tach event will be registered every time the “Trigger 

Level” is crossed upwards by the signal.  

 Negative:  

“Slope” option “Positive” means a tach event will be registered every time the “Trigger 

Level” is crossed downwards by the signal.  

 Both:  

“Slope” option “Positive” means a tach event will be registered every time the “Trigger 

Level” is crossed by the signal.  

6.52 Spectral Lines 

The spectral lines option enables the user to retain all the spectral lines available (1/2 

the Blocksize) or keep about 80% of the spectral lines. The upper 20% of the spectral 

lines are typically in the transition band of the acquisition systems auto-aliasing filters, 

and may contain slight to moderate errors in amplitude. 

6.53 Tachometer Processing 

The Tachometer Processing Module can be activated in two ways. Tachometer 

Processing can be activated by selecting “Tachometer Processing” from the “Analysis” 

menu. It can also be activated by clicking the <Tachometer Processing> button from the 

toolbar. 

It is possible to perform a torsional analysis along with the tachometer processing 

through the Preferences dialog window. 

6.54 Tachometer Pulses per Revolution 

Normally, one pulse is registered per revolution. A value can be entered in this window 

to increase or decrease this rate. 

6.55 Tachometer Type 

ibaRotate supports Pulse Tachometer Signals and DC Tachometer Signals. A Pulse 

Tachometer represents a periodic waveform where the instantaneous speed is 

determined by the distance of periodic events, such as a level crossing in the up or down 

direction. A DC Tachometer represents a signal whose amplitude is proportional to the 

actual RPM. 

6.56 Torsional Analysis 

By torsional vibration in ibaRotate, we really mean angular vibrations of a rotating shaft. 

We obtain a time history of angular shaft speed sampled at constant sampling rate by 

using special settings in the tachometer analysis. The angular speed is given in degrees 

per seconds, which, when multiplied by 360, becomes revolutions per second. 

You can create a time history of angular velocity sampled at equidistant time points by 

checking the “Create degrees torsion file during tachometer processing” checkbox in the 
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Preferences dialog from the Edit menu. You must also specify which sampling frequency 

you want the torsion file to have.  

When a tachometer analysis is done with this option enabled, a file with a .tor extension 

will be created. This file can be analyzed just like any other sampled time history for 

orders, frequencies and transient phenomena. 

The tachometer signals used in torsional analysis must be in pulse form and there must 

be more than one pulse per revolution. Normally, in order to look at an angular fluctuation 

of order N, at least 2N+1 pulses per revolution are needed. The analysis that based on 

the tachometer signal is a pure time domain operation, so be careful of the ringing that 

is often introduced by antialiasing filters. 

6.57 Tracking Method 

 Time Tracking Method 

The User specifies a Minimum, a Maximum and an Increment of time (or a Frequency, 

the Increment’s inverse) for which to obtain spectra. The number of spectra obtained will 

be figured out by ibaRotate from this data. As a safety precaution, the user may specify 

a spectra ceiling in the Maximum Number of Spectra box.  

 RPM Tracking Method 

The User specifies a Minimum, a Maximum and an Increment of RPM for which to obtain 

spectra. The number of spectra obtained will be figured out by ibaRotate from this data. 

As a safety precaution, the user may specify a spectra ceiling in the Maximum Number 

of Spectra box. 

 None 

In this case, the user just specifies the required number of spectra in the “Number of 

Spectra” box. ibaRotate will calculate the required intervals. 

6.58 Tracking Type 

Tracking may be chosen as “Run Up” or “Run Down” when tracking method is chosen 

as “RPM”. 

6.59 Trigger Level 

The “Trigger Level” is a real number, depicting a significant tachometer signal intensity, 

which can be typed in by the user. It should be chosen sufficiently high such as to prevent 

noise level signals to cause triggers, and sufficiently low such as not to miss actual peaks 

that should cause triggers.  

Reasonable values for “Trigger Level” can be deduced by observing the graph of the 

tachometer signal versus time.   

6.60 Vold-Kalman Filter Properties 

The Vold-Kalman filter (VKF) is an advanced, high-performance filtering method for 

finding orders in systems with closely spaced orders or rapid speed changes. Using a 

tach reference, it can extract waveforms, amplitude and phase with no bias, leading to 

the possibility of editing data with respect to extracted orders. There are also several 

filter shapes provided for optimum resolution and stop-band suppression. 

To use the VKF, select a smoothed RPM signal and an amplitude signal, then either 

choose “VKF Analysis” from the “Analysis” menu or click the <VKF Analysis> button on 

the toolbar. This will bring up the following dialog window: 
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Figure 74: VKF settings 

 

 Width: 

Specifies the bandwidth of the filter in terms of orders. 

 Integrate/Diff.: 

Used to change acceleration data to velocity or position data and vice versa if the 

appropriate data is not available. 

 Complex envelope:  

Creates amplitude and phase functions of the selected orders. 

 Order time history:  

Creates the time histories of the selected orders at the same sampling rate as the original 

signal. 

 Filter Poly Order: 

Controls the selectivity of the VKF filter. 

1 Pole Filter: Quickest calculation time but needs much smaller bandwidth values to 

avoid beating. Represented by the blue line on the Filter Order Representation image. 

Useful mainly for quick calculations or ones involving very little order crossing. 

2 Pole Filter: Intermediate calculation time and can handle larger bandwidth values 

without beating. Represented by the red line on the Filter Order Representation image. 

Useful for most applications. 

3 Pole Filter: Longest calculation time but most accurate. Relatively large bandwidth 

values can be used with little to no beating. Represented by the black line on the Filter 

Order Representation image. Useful when there are many orders crossing resonances. 

 Orders: 

This option enables the user to specify which orders are to be extracted from the data. 

To add an order, type it in the window or select it from the drop-down menu and click 

<Add>. To remove an order from the list, choose it and click <Delete>. 
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 Filter Order Representation: 

This is a graphical representation of the selectivity of the three filters – see Filter Poly 

Order above for more details. 

6.61 Waterfall Analysis 

The Waterfall Analysis Module can be activated in two ways. Before activating Waterfall 

Analysis, make sure to select the data signal and the smooth RPM signal. This will enable 

you to take advantage of ibaRotate’s order cursoring and RPM tracking. Waterfall 

Analysis can be activated by selecting “Waterfall Analysis” from the “Analysis” menu. It 

can also be activated by clicking the <Waterfall Analysis> button from the toolbar.  

6.62 Waterfall Properties 

Selecting the “Properties” option after right-clicking in the Waterfall Plot window will bring 

up the Waterfall Plot Control Properties dialog window.  

6.62.1 General Tab 

 

Figure 75: General tab 

The “General” tab sets some generic properties on the Waterfall plot window.  

 Title:  

Places an additional title text above the plot along with the signal name. 

 Display Total:  

Creates a line on both Waterfall plots displaying total and mean energy as well as 

calculating a value for the total energy. 

 Color coded amplitude: 

Applies the contour plot colors to the Waterfall plot. 

 Resolution Colors: 

Resolution colors specifies the number of color bins to use in creating the contour plot. 

Displaying the color bar will show the data value range and the color associated with 

those values. 
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6.62.2 Cursor Tab 

 

Figure 76: Cursor tab 

The “Cursor” tab enables you to select which axis the cursor will track along and which 

units to use while tracking.  

 Track Axis: 

Changes which axis the cursor tracks along. The drop-down menu can be used to 

change which units the cursor will use. 

 Current Value: 

Positions the cursor at a specific place along the currently selected axis. 

6.62.3  Amplitude Axis Tab 

 

Figure 77: Amplitude Axis tab 

The “Amplitude Axis” tab enables the user to set the scale and limits for the Amplitude 

Axis on the current Waterfall plot as well as adjusting display of the Amplitude Axis. 

 Scale: 

Linear: Sets the scale to Linear based values. 

Log10: Sets the scale to Log10 based values. 

dB: Sets the scale to dB based values. 
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 Units: 

Enables the user to choose the Amplitude axis units when there is more than one option 

(seconds, Hz, RPM, etc...etc.). 

 Limits: 

Auto-scale: Uses absolute minimum and maximum values configured for the Waterfall. 

Auto-scale Optimized: Uses the rounded off minimum and maximum values as limits. 

Fixed: Enables the user to specify the left and right limits. 

 Viewed Data Only:  

When viewed data only is selected, only the data that is being viewed will be auto-scaled, 

rather than the whole data set. 

 Grids:  

Major/Minor Grids: Enables/Disables display of gridlines for major and minor tics along 

the amplitude axis. 

Major/Minor Tics: Enables/Disables display of the major and minor tic marks along the 

amplitude axis. 

Major/Minor Division: Sets the interval between the major and minor tic marks along 

the amplitude axis. These values are set automatically by ibaRotate when this option is 

not selected. 

6.62.4 Z Axis Tab 

 

Figure 78: Z Axis tab 

 

The “Z Axis” (RPM Axis) tab enables the user to set the units, scale and limits of the RPM 

Axis on the current Waterfall plot as well as adjusting display of the Z-axis. 

 Scale: 

Linear:  Sets the scale to Linear based values. 

Log10:  Sets the scale to Log10 based values. 

dB:   Sets the scale to dB based values. 

 Units: 

Enables the user to choose the Z-axis units when there is more than one option 

(seconds, Hz, RPM, etc.). 
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 Limits: 

Auto-scale: Uses absolute minimum and maximum values configured for the Waterfall. 

Auto-scale Optimized: Uses the rounded off minimum and maximum values as limits. 

Fixed: Enables the user to specify the left and right limits. 

 Grids:  

Major/Minor Grids: Enables/Disables display of gridlines for the major and minor tics 

along the Z-axis. 

Major/Minor Tics: Enables/Disables display of the major and minor tic marks along the 

Z-axis. 

Major/Minor Division: Sets the interval between the major and minor tic marks along 

the Z-axis. These values are set automatically by ibaRotate when this option is not 

selected. 

6.62.5  X Axis Tab 

 

Figure 79: X Axis tab 

The “X Axis” (Frequency Axis) tab enables the user to set the units, scale and limits of 

the Frequency Axis on the current Waterfall plot as well as adjusting display of the X-axis. 

 Scale: 

Linear:  Sets the scale to Linear based values. 

Log10:  Sets the scale to Log10 based values. 

dB:   Sets the scale to dB based values. 

 Units: 

Enables the user to choose the Z-axis units when there is more than one option 

(seconds, Hz, RPM, etc...etc.). 

 Limits: 

Auto-scale: Uses absolute minimum and maximum values configured for the Waterfall. 

Auto-scale Optimized: Uses the rounded off minimum and maximum values as limits. 

Fixed: Enables the user to specify the left and right limits. 

 Grids:  

Major/Minor Grids: Enables/Disables display of gridlines for the major and minor tics 

along the X-axis. 

Major/Minor Tics: Enables/Disables display of the major and minor tic marks along the 

X-axis. 
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Major/Minor Division: Sets the interval between the major and minor tic marks along 

the X-axis. These values are set automatically by ibaRotate when this option is not 

selected. 

6.62.6 Numeric Tab 

 

Figure 80: Numeric tab 

The “Numeric” tab adjusts the display of numbers along a specific axis for the current 

Waterfall plot. 

 Numeric Format Properties For: 

Sets the axis to be formatted. 

 Type: 

Fixed: Sets the scale to a fixed number of decimal places based on the precision value. 

Metric:Sets the scale to metric numbers based on the significant digits value. 

Scientific: Sets the scale to scientific numbers based on the exponent width and 

significant digits values. 

Engineering: Sets the scale to engineering numbers based on the exponent width and 

significant digits values. 

 Significant Digits: 

Changes the number of significant digits displayed in the values along the selected axis. 

 Precision: 

Changes the precision of the numbers along the selected axis for Fixed type values.  

 Exponent Width: 

Changes the number of digits used to represent the exponent value for Scientific and 

Engineering type values.  
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6.62.7 Scheme Tab 

 

Figure 81: Scheme 

The “Scheme” tab enables you to change the colors and display properties of the 

different elements in the plot. 

 Scheme: 

Black and White: Sets all of the colors in the plot to black and white.  

Color Printer: Enables the user to specify the colors he wants each element in the plot 

to be. 

Default: Sets the plot to the default colors: green data on a black background. 

Silver Theme: Gray and white colors. 

 Save As: 

Enables the user to save a color scheme to select later or for use in other Waterfall Plot 

windows. 

 Color Map:  

Defines the color map scheme used for contour plots. 

 Element: 

Select an element from the drop-down menu. Any display properties (color, font, etc.) 

associated with it will be available for modification in the options below. Data1 is the color 

of the data in the Waterfall plot. 

 

 

Note 

The Line Style and Marker options only change the display of data in the upper pane of 

the Waterfall Plot window. 

 

 See also: How to Add/Delete Cursors and Cursor Options 
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6.63 Weighting 

Weighting is an advanced feature, usually used in the acoustics field. The resulting 

spectra are weighted by a frequency-dependent function. The choices are: 

No-weighting:  Data plotted as given 

A-weighting:  Closely models the human hearing range, filtering out high 

and low frequencies 

B-weighting:  Rarely used filter between A and C-weighting 

C-weighting:  Relatively flat filter that more accurately models human 

hearing at high noise levels 

Wz- (Body Vert):  ISO 2631 

Wxy- (Body Horz):  ISO 2631 

H- (Hand Arm):  ISO 5349 

 

6.64 Width 

Used to determine the bandwidth of the order tracking. If the user is extracting orders of 

1, 2, 3, 4, etc., a bandwidth of 0.1 or so is appropriate. If orders 5, 10, 15, 20 are selected, 

then a bandwidth of 0.5 would be appropriate. 

6.65 Window 

Windows are needed in most signal processing situations to prevent what is known as 

leakage, which may occur when applying the Fast Fourier Transform (FFT). The FFT 

works with power of 2 data block sizes that must be periodic in the sample period or 

should start and end with a value of zero to prevent leakage. This is usually not the case 

with most measured data. Most windows will artificially introduce near-zero values at the 

block ends. However, this is usually achieved at the expense of frequency resolution, so 

there is not one window that is ideal for all cases. The windows available in ibaRotate 

are: 

 Hanning: 

This widely used window has a reasonable ability of distinguishing between two peaks 

that are closely spaced in frequency. Peak amplitudes may be underestimated by as 

much as 15%. 

 Flat Top: 

This window is very good for accurate amplitude estimation (within 1%). However, it has 

the poorest capability to distinguish between two peaks of similar amplitude that are 

closely spaced in frequency. 

 Hamming: 

This window is most useful for identifying peaks that are closely spaced in frequency. 

However, peak amplitudes may be underestimated by as much as 18%. 

 Uniform: 

This window is useful for signals that are periodic in the sample period or should start 

and end with a value of zero. In other cases, it will cause a large amount of leakage; it 

really is equivalent to using no window at all. 
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6.66 Window Correction 

 Peak Correction: 

Peak Correction is used for zero to peak scaling.  

 RMS Correction: 

RMS Correction uses root mean square. 

 PSD Correction: 

PSD Correction uses the power spectral density value.  

 Millstrum Correction: 

Millstrum Correction – Real cepstrum analysis. 

 Synchronous Correction: 

Synchronous Correction specifics synchronous averaging.  

 

6.67 Zoom 

This enables you to look closer at a particular region of the Waterfall, Contour, or Two 

Dimensional plot. After selecting “Zoom” from the right-click menu, the mouse pointer will 

turn into a cross-hair cursor. Place the cursor where you want to begin and drag it over 

the region you want to zoom in. This will create a square region on the plot. Everything 

within this square will be rescaled to fit the window for a closer view. Below is an example 

using a two-dimensional plot. 

 

 

Figure 82: Zooming function 

 

The result of zooming in on the above section, outlined by the white square, can be seen 

below: 
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Figure 83: Zooming result 

 

To zoom out, choose Auto-scale from the right-click menu. 



 Manual ibaRotate 

 

100 Issue 1.0 
 

 

7 File Formats for Import / Export 

File formats imported or exported by ibaRotate are described below. 

7.1 CSV / ASCII files (.csv, .asc) (import) 

Multiple signals may be imported from a single CSV (comma separated values) text file. 

The name “ASCII” is sometimes used to describe these files also, and is considered 

equivalent to “CSV” by ibaRotate. 

Contrary to the “CSV” name, CSV files may have tab or space or comma delimiters. The 

CSV filename may have any extension, such as .csv, .asc, .txt, etc. 

Each column of values will be imported as one signal. If a column has the name “time”, 

that column will be interpreted as the abscissa values for all signals. 

An example CSV file with 4 signals is: 

*time, tach, accel01, accel02 

*sec, volt, g, g 

0.0, 0.0, 0.1, -0.1 

0.1, 1.0, 0.2, 0.0 

0.2, 1.0, 0.3, 0.1 

0.3, 0.0, 0.2, 0.1 

0.4, 0.0, 0.1, 0.1 

… 

Notes: 

1. Signals (columns in the CSV file) may be delimited with spaces, tabs, or commas.  

2. Up to 2 header lines may be included (must precede data lines). The first header 

line (if present) defines signal names, and the second header line (if present) 

defines units. 

3. The first one or two lines will be processed as header lines for either of two 

conditions:  

(1) There is a “*” or “$” in the first column, as in the example above, or  

(2) Any field on the header line contains character data that can not be interpreted 

as a decimal value. 

4. If any column has a name “time”, then that column will be used as the abscissa 

values for all other columns. If no column is labeled “time”, then the default 

sampling frequency from the “Edit/Preferences” form will be used to define the time 

values, starting at 0.0. 

5. Current max line length = 8192 characters. 

6. Current max number of signals in one CSV file = unlimited. 

7. Rotate 2.9.0 and previous versions imported ASCII files with tab delimiters only. 

Rotate 2.9.1 and later will import the previous ASCII files, as well as general ASCII 

or CSV files as described above. 
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8 Support and Contact 

Support 

Phone: +49 911 97282-14 

Fax: +49 911 97282-33 

E-Mail:  support@iba-ag.com 

 

 

Note 

If you require support, specify the serial number (iba-S/N) of the product. 

 

Contact 

Headquarters 

iba AG 

Postbox 1828 

DE-90708 Fürth 

Germany 

 

Phone.: +49 911 97282-0 

Fax:  +49 911 97282-33 

E-mail: iba@iba-ag.com 

 

Shipping address 

iba AG 

Gebhardtstr. 10 

DE-90762 Fürth 

Germany 

 

Regional and Worldwide 

For contact data of your regional iba office or representative please refer to our web site 

www.iba-ag.com. 
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